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Introduction 

 
OneLaw offers a number of capabilities to deliver a comprehensive document assembly and precedents 
system. Each firm can use as few or as many of the features available to increase efficiency. 
 

 
 
The capabilities that comprise OneLaw document assembly are outlined in the table below: 
 

Feature Capabilities 

Signatures + Store signatures on the user record 
+ Define signature delegation rules 
+ Sign documents directly in Word 
+ Create signature placeholders in precedents 
+ Handles multi-signing scenarios 

Stationery – Headers & Footers + Store letterhead in OneLaw 
+ Define firm default letterhead 
+ Supports multiple letterhead options 
+ Manually apply letterhead to documents, or automatically 

apply default letterhead when running precedents 
Stationery – StyleSheets + Define StyleSheets containing firm styles for various use 

cases (letter, court, deed/agreement etc.) 
+ Apply StyleSheet styles to documents 

Fields + Includes OneLaw data in documents using fields 
+ Supports both content controls and merge fields in Word 
+ Access to a wide range of built-in fields, as well as custom 

fields via InfoSheets 

InfoSheets + Define InfoSheets containing related sets of custom fields 
+ Attach InfoSheets to matters with relevant fee types, or 

show as a dialog box when running a precedent or 
inserting a clause/fragment 

+ Supports a wide range of field types 

Clauses & Fragments + Define and manage small pieces of content to be inserted 
into documents, either manually or automatically when 
running precedents 

+ Associate Clause Libraries with fee types and make them 
available to insert in relevant documents 

Precedent Libraries + Define named libraries of precedents associated with 
particular fee types 

+ Run precedents from within OneLaw and automatically 
populate with correct client/matter information 

Email Precedents + Create precedents containing common email content 
+ Automatically populate emails with OneLaw built-in and 

InfoSheet fields 

NOTE: OneLaw document assembly was previously known as OneAuthor. OneAuthor was historically 
delivered as some simple field capabilities in OneLaw along with a VBA solution customised for each 
customer. 
 
As OneLaw has moved away from VBA, we have also moved away from the OneAuthor branding. 
OneAuthor is now known as document assembly, and the old VBA functionality is known as legacy 
OneAuthor. Please also note, there is still some OneAuthor branding within the product at this time; this 
will be removed in due course. 
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There are a number of other OneLaw features closely related to document assembly that are mentioned but 
not specifically covered in this manual. These include: 
 

+ Document management (formerly OneDesktop) 

+ Statement templates 
 

VBA 

 
While there are still firms using legacy OneAuthor with VBA, this manual specifically does not cover VBA. For 
assistance with VBA-based functionality, please contact OneLaw support: support@onelaw.co.nz or 03 339 
5032. 
 

Create Mode vs Edit Mode Functions 

 
When working with documents, OneLaw document assembly capabilities can be divided into Create Mode 
capabilities and Edit Mode capabilities: 
 

+ Create mode capabilities: These capabilities occur during the process of creating a document 
from a precedent – generally called “running a precedent” or “executing a precedent” 

+ Edit mode capabilities: These capabilities are available when editing a document. Many of these 
capabilities are available for any document, but some are only available for certain documents 
created from precedents 

 
Specific capabilities and which modes they are available for are outlined in the table below. 
 

Capability Create mode Edit mode 
Sign document   
Manually apply header/footer   
Auto-apply default header/footer    
Apply StyleSheet styles   
Fill document fields   

Manually insert clause/fragment   
Auto-insert clause/fragment   

Display Prompt InfoSheet   

Display Fragment/Clause InfoSheet   
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User Interface 

 
See the instructions and figures below for the key User Interface entry points for users, administrators and 
template authors. 
 

Users 

 

In Word 
 

1. Run an internally stored precedent/template 

2. Show the Signature dialog to insert a signature 

3. Access the Stationery menu to access to header & footers and StyleSheets 

4. Access the Fragments/Clauses menu to insert a predefined Fragment or Clause 

 

 

Figure 1 

 

In OneLaw – Home tab, matter view 

 
1. View/edit InfoSheets available for this matter 

2. View/run precedents available for this matter 

 

 

Figure 2 

 

In OneLaw – Documents tab 

View/run precedents available for this party/matter. 

 

 

Figure 3 
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Administrators 

 

In Word 

 

 

Figure 4 

 
1. Create a new template/precedent 

2. Edit an existing internally stored template  

3. Save the currently open template/precedent to the internal template store 

4. Show the template settings for the currently open template/precedent 

5. Show the stationery settings for the currently open template/precedent 

6. Open the Attach/Repair dialog 

7. Delete a template from the internal template store 

8. Open the attached InfoSheets dialog for the currently open template/precedent 

9. Show the built-in/InfoSheet fields in the currently open template/precedent, allowing drag-drop 

insertion of content control fields 

10. Show the current XML data binding of the selected content control 

11. Open a list of available merge fields in a new Word document 

12. Show the log files directory (when requested by OneLaw Support) 

 

In OneLaw – Administration tab 

 

 

Figure 5 

 

1. Manage Precedent Libraries and Clause Libraries 

2. Manage various templates, including: 

a. Headers & footers 

b. StyleSheets 

c. Fragments 

3. Manage InfoSheets 

4. Manage File Sets (NOTE: File Sets are a supporting function for the legacy OneAuthor, and as such are 

not covered in this manual) 
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Licencing and Permissions 

 

Licencing and Settings Managed by OneLaw 

Document assembly is now included with all OneLaw implementations, however historically, document 
assembly was an optional add-on. When document assembly is not licenced, a number of features described 
in this manual are not available. 
 
Some other features described in this manual are enabled for all new OneLaw customers, but not available 
by default for existing OneLaw customers (with document assembly licenced) due to the change 
management process required to switch from the legacy OneAuthor functionality. 
 
The table below indicates which features are always available, which features require document assembly 
licencing to be enabled and which features need to be enabled by OneLaw as part of a change management 
process for customers using the legacy OneAuthor. 
 

Feature Always available Needs document 
assembly licence 

Needs document 
assembly licence and 

additional 
configuration 

InfoSheets    

Precedents and Templates    

Precedent Libraries    
Email Precedents    

Clauses & Fragments    
Signatures    
Stationery – Headers & Footers    
Stationery – StyleSheets    
Bidirectional Data Flow    

 
If your firm is not licenced for document assembly and would like access to the above features, or your firm 
is licenced for document assembly, but you don’t yet have access to the features above, then please reach 
out to OneLaw support in the first instance. 
 

Template Administrator Permission/Role 

Certain functions used to administer or author templates/precedents and related capabilities are controlled 
by a Template Administrator permission. This includes access to the Templates section on the Administration 
tab, and the entire OneAuthor tab in Word. 
 

 

Figure 6 
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Figure 7 

It is possible to give users access to the Templates section in OneLaw without providing access to all other 
admin functions. In this case, the Administration tab is replaced with a Templates tab, which contains only 
the Templates section. 
 

 

Figure 8 

 

Adding a Template Administrator Role 

It is recommended to add a Template Administrator role, which includes the Template Administrator 
permission. This provides access to template authoring functions without providing access to general firm 
administration functions. To do this, open OneLaw and navigate to the Administration tab. Select Roles and 
click on the green plus (+) to add a new role. 
 

 

Figure 9 

Fill in the Name and Description fields with Template Administrator, then select Choose Permissions. Scroll 
down the permissions list to the heading Administration. At the end of this section, check the box for 
Template Administrator. Click OK, then Save & Close. 
 

 

Figure 10 
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Figure 11 

Open the Maintain Staff dialog by clicking Users on the Administration tab. 
 

 

Figure 12 

For each user that needs the Template Administrator role, open the user profile and under Roles, check the 
box for Template Administrator. Click Save & Close. 
 

 

Figure 13 
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Documents & Precedents 
 

Introduction 

 
OneLaw defines multiple types of templates and precedents. The three types covered in this manual are: 
 

+ Document templates and precedents – covered in this section 

+ Email precedents – covered in the Email Precedents section of this manual 

+ Statement templates – covered in the Statements Manual, but overlaps with content in this 
manual, as statement templates can also use built-in and InfoSheet fields 
 

This section covers document templates and precedents. 
 
Terms: 
 

+ Template: Document used to create other documents, containing reusable layout, styles and 
automation. Typically, does not include IP 

+ Precedent: Document or template containing re-usable content (IP), with or without 
automation, used to generate a document 

+ Document: Any document, either created from scratch, a template, precedent or received from 
another party 
 

In OneLaw terms, the flow generally goes as follows: 
 

 

Figure 14 

  

Template 

Precedent 

Document 

Precedents can be created from base 
templates and inherit layout, styles and 
automation.   

Precedents are used to create documents. 
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Precedent Automation Types 

 
There are three types of precedent automation in OneLaw: 
 

+ None: Just a document. Any document containing content that is made available in OneLaw as a 
precedent but does not use any document assembly features such as fields, clauses or 
InfoSheets. Can be in Word document or template (.docx, .docm, .dotx, .dotm) format 

+ Partial: A precedent with automation in a Word document (.docx or .docm) format. These 
precedents support limited create mode features – only field mapping into content control 
fields. Fields can come from built-in fields or Matter InfoSheets. Does not support merge fields, 
Clauses/Fragments, Prompt InfoSheets 

+ Full: A precedent in Word template (.dotx or .dotm) format. These support all create mode 
features, such as merge fields, Clauses, Fragments and Prompt InfoSheets 

 
NOTE: Word templates (.dotx, .dotm) require correct settings to enable all features of full automation.  
Specifically, the setting “Template uses MergeFields” must be enabled. For more details, see the 
Template/Precedent Settings section below. 
 
The following table outlines which OneLaw document assembly capabilities are available for each precedent 
automation type. Where “None” is ticked under precedent automation type, these capabilities can be used 
with any document. 
 

  Precedent automation type 
Capability Mode None Partial Full 

Fields     

  Built-In fields Create    
  InfoSheet fields Create    
  Populate content control fields Create    
  Populate merge fields Create   * 

InfoSheets     

  Prompt InfoSheets Create    
  Clause/Fragment InfoSheets (on run precedent) Create    
  Clause/Fragment InfoSheets (manually from menu) Edit    
Clauses/Fragments     

  Insert clause (chosen in InfoSheet) Create   * 
  Insert Clause (OA INCLUDE) Create   * 
  Insert clause (x picker) Edit    
  Insert clause (manually from menu) Edit    
Signatures     
  Insert signature at cursor Edit    
  Insert signature at placeholder Edit    
Stationery – Header & Footer     

  Apply default stationery (on run precedent) Create    
  Apply or clear stationery (manually from menu) Edit    
Stationery – StyleSheets     

  Apply styles from StyleSheet Edit    
 
* The asterisked features in the table above require the “Template uses MergeFields” setting to be enabled in 
the precedent.  
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Precedent Execution 

 
“Precedent Execution,” or “Running a Precedent,” are terms used to describe the process of generating a 
document from a precedent. This is a similar concept to generating a Word document from a Word template, 
where double-clicking the Word template does not edit the template, but instead creates a new document 
based on the template. 
 
OneLaw is designed to create new documents from precedents that are both Word documents (.docx, 
.docm) and Word templates (.dotx, .dotm). This process always creates a new document which contains the 
content of the precedent and associates the document with a party and/or matter in OneLaw. 
 
Exactly how this works depends on the automation type of the precedent and where the precedent is 
executed from. Precedents can be executed from 3 locations: 
 

+ Internal template library: This is the legacy OneAuthor template location, where 
templates/precedents are stored in the OneLaw document management system and cached 
onto each PC 

+ Precedent Library: These are precedents stored in folders outside of OneLaw, typically a shared 
drive or SharePoint. Precedent Libraries allow these precedents to be executed from within 
OneLaw 

+ External access via folder: Full automation precedents can be configured to be able to run 
directly from an external folder, by double-clicking in Windows Explorer, without requiring 
access via a precedent library. For more details, see Template/Precedent Settings below 
 

The following table shows which precedent automation types are supported by the different precedent 
locations: 

 Precedent automation type 
Precedent execution location None Partial Full 

Internal template library    
Precedent Libraries    
External access via folder    

 
NOTE: Precedent Libraries can be configured for the type of precedent automation they support. See the 
section on Precedent Libraries for details. 
 

Base Templates 

 
Base templates are Word templates used to create precedents. They are typically used to allow shared styles, 
layouts, etc. to be reused. Base templates are created and managed like precedents in an internal template 
library. When saving a template/precedent to the internal library, there is an option to specify it as a Base 
Template. When selected, the following rules apply: 
 

+ The template cannot be executed directly to create a document, i.e. it does not appear to end 
users as a precedent in the internal template library 

+ When creating a new precedent, it can be based on a base template. When this is done, all styles 
and content from the base template are pulled into the new precedent 

 
Base templates support all the same features as precedents, and new precedents created from base 
templates will inherit any automation from the base template. 
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Template/Precedent Settings 

 
Several settings control how precedents are executed: 
 

1. Template Uses MergeFields: On a full automation precedent, this specifies whether merge fields will 
be processed/populated. There is a small performance penalty for processing merge fields, so if a 
.dotx/.dotm precedent does not use merge fields, this can be disabled to speed up execution. 

2. Flatten Fields After Merge: When merge fields have been processed, this setting specifies whether to 
‘flatten’ any IF fields in the body of the document. This effectively removes the IF field objects and 
leaves behind just the resulting text. This can be used if it is not desirable to leave complex IF fields 
behind after running the precedent. NOTE: This process only affects the body of the document; it 
does not modify fields in the Header/footer. 

3. Execute on New Document Creation: For full automation precedents stored in an external folder, 
this setting specifies whether to execute the precedent automation when a new document is created 
from the Word template, even when this happens outside of OneLaw (e.g. by double-clicking the 
precedent file in the file explorer). This setting is very useful to precedent authors working on 
precedents locally before publishing them in a Precedent Library. 

 
These settings can be accessed in several places. Settings 1 and 2 can be set when first creating a 
template/precedent in the New Template dialog, accessible from the New Template button in the OneAuthor 
ribbon: 
 

 

Figure 15 

They can also be set in the Template Properties dialog, accessible from the Template Properties button on 
the OneAuthor ribbon: 
 

 

Figure 16 
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Or: 
 

 

Figure 17 
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How To – Base Templates 

 
Users with the Template Administrator permission can create base templates. To create a base template, 
open Word and navigate to the OneAuthor tab. Select New Template.  
 

 

Figure 18 

A New Template dialog will open and provide the following options for the template: 
 

+ Template Name: Enter an appropriate name for the template 

+ Based On: Leave this as None, as this precedent will become a base template 

+ Template Plugin: Leave this as None, as this field is to support legacy VBA solutions 
 

If the base template uses merge fields, then tick Template Uses MergeFields. It is recommended that the 
Flatten Fields After Merge remains unticked. Refer to the above Template/Precedent Settings section for 
more details on this. 
 

 

Figure 19 

Once the New Template properties have been filled in, click OK.   
 
If the base template should include your firm’s default header & footer from OneLaw, you can click the 
Template Stationery button. 
 

 

Figure 20 
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A Default Stationery Settings dialog will open and provide the option to only apply stationery to the first 
page of the base template or to automatically apply the default stationery to the base template upon 
execution of any precedents based on this base template.  
 

 

Figure 21 

InfoSheets can be attached to base templates by selecting the InfoSheets button in the InfoSheets tab. Refer 
to the InfoSheets section of this manual for more information. 
 
Insert content for the base template. 
 
Once the base template is finalised and ready to be saved, select Save Template. A Save Template dialog will 
open and provide the following options for the base template: 
 

+ Template Name: This will automatically populate with the template name preset in the above 
step to set up a New Template. This can be overridden at this point 

+ Template Type: This allows for the precedent to be either a User Precedent or a Base Template. 
For base templates, select Base Template from the dropdown box 

+ Category: As this is a base template, this option won’t be available 
 

 

Figure 22 
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Once a base template has been saved, if amendments need to be made, select the Edit Template button on 
the OneAuthor tab. The dropdown will show Base Templates first, with a sidebar showing all base templates. 
Click on the base template that requires editing, and it will open in a new window. After all amendments 
have been made, save the base template by selecting the Save Template button. 
 

 

Figure 23 
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How To – Internal Precedent 

 
Users with the Template Administrator Role have permission to create internal precedents. The process to 
create internal precedents is the same as creating base templates, with a small change for how to save the 
document, as noted further down this section. 
 
To create an internal precedent, open Word and navigate to the OneAuthor tab. Select New Template.  
 

 

Figure 24 

A New Template dialog will open and provide the following options for the internal precedent: 
 

+ Template Name: This is what will prepopulate in the Document Name when users run the 
precedent from within OneLaw 

+ Based On: There is the option to base the new precedent on an existing one. The dropdown will 
give all available base templates to use 

+ Template Plugin: Leave this as None as this field is to support legacy VBA solutions 

+ If the new precedent will be using merge fields then check the Template Uses MergeFields box. 
It is recommended that the Flatten Fields After Merge remains unticked. Refer to the above 
Template Properties section for more detail on this 

 

 

Figure 25 

Once the New Template properties have been filled in, click OK.   
 
If the internal precedent should include your firm’s default header & footer from OneLaw, you can click the 
Template Stationery button.  
 

 

Figure 26 
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A Default Stationery Settings dialog will open and provide the option to either only apply stationery to the 
first page of the internal precedent or to automatically apply the default stationery to the internal precedent 
upon execution of the internal precedent.  
 
Both these check boxes can be ticked if the internal precedent should use both options. If the internal 
precedent is based on a base template that uses Template Stationery, then the Auto Apply Default 
Stationery will already be prepopulated. This can be overridden and deselected at this point. 
 

 

Figure 27 

InfoSheets can be attached to the internal precedent by selecting the InfoSheets button in the InfoSheets 
tab. Refer to the InfoSheets section of this manual for more information. 
 
The next step is to insert the content required for the internal precedent. This could be starting from scratch 
or simply copying and pasting the content from another document. 
 
Once the internal precedent is finalised and ready to be saved, select Save Template. A Save Template dialog 
will open and provide the following options for the internal precedent: 
 

 

Figure 28 

+ Template Name: This will automatically populate with the template name preset in the above 
step to set up a New Template 

+ Template Type: This allows for the precedent to be either a User Precedent or a Base Template. 
For internal precedents, select User Template from the dropdown box 
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+ Category: For internal precedents, Categories act like a folder structure where there can be a 
main folder followed by subfolders of internal precedents. For the example below, in the 
Category field type: Bex Templates > Client Information – the Test template #3 would be located 
in this subcategory once saved 

 

 

Figure 29 

Once an internal precedent has been saved, if amendments need to be made, select the Edit Template 
button. The dropdown will show Base Templates first and then all internal precedents. Click on the internal 
precedent that requires editing, and it will open up in a new window. After all amendments have been made, 
save the internal precedent by selecting the Save Template button. 
 

 

Figure 30 
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How To – External Precedent 

 
Users with the Template Administrator permission can create external precedents. There are two ways to 
create an external precedent, with each being appropriate for different solutions. In both cases, once the 
precedent is created, it gets saved to an external location rather than the internal templates area. 
 

Method 1 – New Template Button 

This method is best when a brand-new precedent is required, or a precedent based on a Base Template. 
 
This process starts exactly the same as when creating an internal precedent, but rather than saving to the 
internal templates area, it instead saves to an external location. 
 
Follow the instructions in the How To – Internal Precedent section up until the precedent is saved. Then, 
instead of using the Save Template button, use the built-in Word save function to save the precedent to an 
external location. 
 

Method 2 – Attach/Repair Existing Document 

This method is best if you have an existing document (e.g. a precedent from another system) that you wish to 
turn into a OneLaw precedent. 
 
To convert a document to an external OneLaw precedent, open the document in Word and navigate to the 
OneAuthor tab. Select Attach/Repair > Current Document > Attach/Repair. This will link the document to 
OneLaw as a precedent. See the Attach/Repair   

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

20 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

Attach/section in this manual for more information. 
 

 

Figure 31 
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Once that has been done, select Template Properties, which will open the following dialog and provide the 
following options for the external precedent: 
 

+ Template Name: This is what will pre-populate the document name when users run the 
precedent from within OneLaw 

+ If the new precedent will be using merge fields, check the Template Uses MergeFields box. It is 
recommended that the Flatten Fields After Merge remains unticked. Refer to the above 
Template/Precedent Settings section for more detail on this 

+ Execute on New Document Creation: Ensure this box is checked and click OK 
 

 

Figure 32 

 

Use the Template Stationery tool if the external precedent should include the default header and footer 
from OneLaw. 
 

 

Figure 33 

The Default Stationery Settings dialog will open and provide the option to only apply stationery to the first 
page of the external precedent or to automatically apply the default stationery to the external precedent 
upon execution. 
 

 

Figure 34 

InfoSheets can be attached to the external precedent by selecting the InfoSheets button in the InfoSheets 
tab. Refer to the InfoSheets section of this manual for more information. 
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The next step is to insert the content required for the external precedent. This could be starting from scratch 
or by simply copying and pasting the content from another document. Once the internal precedent is 
finalised and ready to be saved, navigate to the File tab, click Save As and save to the firm’s external 
precedent library folders as either: 
 

+ A Word document (.docx file) if the external precedent contains no automation; or 

+ A Word template (.dotx file) if the external precedent contains automation, including the use of 
merge fields and/or content controls 
 

Refer to the Managing Precedent Libraries section of this manual for more information. 
 
 

Editing External Precedents 

 
Updates to external precedents referenced in Precedent Libraries will update in OneLaw in real time. See the 
Precedent Libraries section for more information. 
 
When working with external precedents, it is generally best to edit local copies of the precedents rather than 
the live copies located in the Precedent Libraries. This is particularly important in a SharePoint environment 
to avoid sync issues or conflicts. Once the precedent is ready, it can then be saved back to the live location. 
 
To edit a precedent from within an external folder: 
 

1. Copy the precedent to a location on the local hard drive 

2. Open the precedent in Word 
NOTE: To correctly open the original document, right-click on the precedent in the external folder 
and scroll down to open. Double-clicking on the document will open up a “copy” of the precedent. 

3. Edit the precedent as required 

4. Test by double-clicking the edited precedent. This should trigger the document assembly process and 
show the New Document dialog. If this doesn’t happen, confirm “Execute on New Document 
Creation” is checked in Template Properties (see Figure 32) 

5. When the precedent is ready, copy it back to the live location 

6. Changes to precedents from within these external folders will copy down to the Precedent Libraries 
within OneLaw and will be available to all users in real-time 
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Attach/Repair 

 
Attach/Repair is like a Swiss army knife of tools, which collectively provide the following key functions: 
 

1. Attaching precedents from other sources to the current firm’s precedent library. These could be: 
a. Documents that we want to use as precedents 
b. Precedents from another system 
c. OneLaw precedents attached to a different firm (e.g. a sandbox) 

2. Repairing issues with precedents attached to the current firm, such as: 
a. Compatibility mode 
b. Missing base schema XML Part 
c. InfoSheet not matching the latest InfoSheet definition 

3. Bulk application of template/precedent settings, as outlined in the Template/Precedent Settings 
section of this manual 

 
Attach/Repair can be run on a single document/precedent, or in bulk on a folder of documents/precedents 
or the internal precedent library. Attach/Repair performs the following functions: 
 

Feature Optional Single Bulk -
internal 

Bulk -
folder 

Take document out of Word ‘Compatibility Mode’     
Convert document to OneLaw Precedent     
Embed XML Part for Build-In fields (Base schema)     
Set Firm ID to current Firm     
Update any known InfoSheets to latest version     
Set template/precedent settings in bulk for the following 
settings: 

+ Template Uses MergeFields 

+ Flatten Fields After Merge 

+ Execute on New Document Creation 

    

Save as .dotx/.dotm. (convert Word document to Word 
template)     

Re-map fields from other system to OneLaw merge fields.  
This includes other system merge fields and DocVariable 
Fields. See the Re-Mapping Fields section for more 
information. 

    

 

Logs and Dry Runs 

Every time Attach/Repair is executed, it creates a Log file in the OneLaw logs folder. This folder can be 
accessed by clicking “Show Log Files” on the OneDesktop tab. Log files are named: 
AttachRepair_[date]_[time].log, e.g. AttachRepair_20250626_164306.log where [date] is 26 June 2025, and 
[time] is 4:43:06 pm. 
 
If there are any errors or warnings generated by the Attach/Repair process, the log file will be opened 
automatically at the end of the process. 
 
For bulk Attach/Repair runs, it’s possible to perform a dry run. When a dry run is performed, the full process 
is executed, but the resulting changes to the files are not saved. This is to allow logs to be reviewed for any 
issues prior to actually making any changes.   
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NOTE: It is highly recommended to perform a dry run and review the log prior to running Attach/Repair on 
the internal precedent library, as the changes cannot easily be undone. 
 
 

Using Attach/Repair 

Attach/Repair can be accessed from the OneAuthor tab in Word: 
 

 

Figure 35 

This shows the Attach/Repair dialog: 
 

 

Figure 36 

NOTE: The Attach/Repair user interface refers to precedents as templates. A future user interface tidy-up will 
standardise terminology per the definitions at the beginning of this document. 
 

Single Document 

To run the Attach/Repair process on a single document, open the document, and then run the Attach/Repair 
on the Current Document, per the dialog above. When the process is run, the processes marked as “Single” 
in the table above will be run against the currently active document. If there are any warnings or errors, the 
log file will be displayed. 
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Bulk – Internal Precedent Library 

To run the Attach/Repair process on all templates/precedents in the internal precedent library, select Internal 
Template Library in the Attach/Repair dialog. It will then present some further options: 
 

 

Figure 37 

There are options to update settings in bulk for all precedents in the internal library, perform a dry run and a 
checkbox to confirm that the warning has been read and understood. 
 
When Attach/Repair is run by clicking the Attach/Repair button, the processes marked as “Bulk - Internal” in 
the table above will be run against every precedent in the internal precedent store. If Perform Dry Run is 
selected, then the documents will not actually be saved, but the log file will still reflect the entire process. 
 
If there are any warnings or errors, the log file will be displayed. 
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Bulk – External Precedent Library 

To run the Attach/Repair process on all Documents/Precedents in a folder, select External Template Library in 
the Attach/Repair dialog. It will then present some further options: 
 

 

Figure 38 

In this case choose the folder containing the precedents to run the process over. 
 
There are options to update settings in bulk for all precedents in a folder, to save all files as Word templates, 
to remap merge fields and DocVariable fields to OneLaw merge fields, to perform a dry run and a checkbox to 
confirm that the warning has been read and understood. 
 
The setting “Template Uses MergeFields” along with “Save Word documents as Word templates” allows 
precedents to be converted from Partial Automation to Full Automation in bulk. See the Precedent 
Automation Types section for more information. 
 
For more information on re-mapping fields, see the Re-Mapping Fields section below. 
 
When Attach/Repair is run by clicking the Attach/Repair button, the processes marked as “Bulk - External” in 
the table above will be run against every precedent in the folder and any sub-folders. If Perform Dry Run is 
selected, then the documents will not actually be saved, but the log file will still reflect the entire process. 
 
If there are any warnings or errors, the log file will be displayed. 
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Re-Mapping Fields 

Fields can be re-mapped by providing a CSV with the before and after fieldnames. This should be a simple 2 
column CSV file, for example: 
 

 

Figure 39 

Column A contains the From fieldname. If the field is a DocVariable field, then prefix with “DOCVARIABLE:” 
per the example. 
 
This process allows: 
 

+ Bulk mapping from one InfoSheet definition to another – for example when the InfoSheet prefix 
has changed. Lines 1 and 2 in the example above show this, where the InfoSheet prefix is being 
changed from “Will” to “NewWill” 

+ Bulk mapping of another system’s merge fields to OneLaw merge fields 

+ Bulk mapping of another system’s DocVariable fields to OneLaw merge fields (using the 
“DOCVARIABLE:” prefix, per line 3 in the example above) 

 
When this process is run, the log file will list all mappable fields in the source documents and what they have 
been mapped to (if anything). This means that the process can be run in dry run mode with an empty CSV file 
to simply produce a log file containing all mappable fields in the source precedents.  
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Precedent Libraries 

 

Introduction 

 
Precedent Libraries are a feature within OneLaw where administrators can set up and map external folders 
that users can access and execute precedents from. Precedent Libraries contain firms’ precedent documents. 
Precedent Libraries can support automated and non-automated Word document precedents and email 
precedents. 

Executing Precedents 

 
There are two areas within OneLaw for users to execute precedents, on a matter or within the Documents 
tab. 
 

 

Figure 40 

 

Figure 41 

To execute a precedent, double-click on the desired precedent or select the precedent and click on Open 
Precedent in the bottom right corner. 
 

 

Figure 42 
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OneAuthor Templates 

 
For those on an older version of OneLaw (prior to version 4.2.2), firms will have legacy OneAuthor Templates. 
Existing OneAuthor Templates are available in Word. 

 

Figure 43 

Existing OneAuthor Templates can also be accessed and executed from the Precedents area within OneLaw. 
These documents appear under the OneAuthor Templates folder: 

 

Figure 44 

 

  

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

30 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

Managing Precedent Libraries 

 
This section is for System Administrators and/or Template Administrators. 

Navigate to the Administration tab (or Templates tab) in OneLaw. Select Manage Libraries. 

 

Figure 45 

This is where administrators can see the Precedent Libraries set up: 

 

Figure 46 

To create a Precedent Library: 

1. Click the green Plus (+) icon.  The following dialog will present: 

 

 

Figure 47 

2. Fill in the following fields: 

+ Name: Specify the name of the Precedent Library. This will be the name visible in the Precedents 
tab for users. 

+ Folder: Choose the external folder that contains the precedents for this Library. This can contain 
subfolders, which will be available in the Precedents tab. If the folder is a SharePoint location, it 
will be mapped to the user profile of each user. In this case, use %USERPROFILE% so it’s not 
pointing to your user profile on your PC. To do this, instead of 
C:\Users\a.user\OneLaw\Precedents, specify %USERPROFILE%\OneLaw\Precedents. The 
%USERPROFILE% tag will resolve to each users correct user profile path on their PC. 

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

31 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

+ Library Type: Specify whether this Precedent Library will contain Document or Email precedents.  
The rest of these instructions focus on Document precedents. For details on setting up Email 
Precedents, see the  

+  
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Figure 48 

Figure 49 

Email Precedents 

 

+  section. 

+ File Types: Specify what types of Document Precedent will be available in this Precedent Library.  
If all precedents will be Full Automation (see the Precedent Automation Types section for more 
information), then choose “Only Word templates…” If there will be some legacy OneAuthor 
Partial Automation precedents, or some plain Word documents, choose “All Word Files…” 
Generally, when “All Word Files” is selected, “Auto-execute Word documents…” should also be 
selected. The exception is when there are legacy OneAuthor precedents with macros that 
display the Edit Document dialog. 

+ Fee Types: Precedent Libraries can be set to only be visible for matters with certain fee types.  
Specify one or more fee types and/or sub fee types for the Precedent Library. If the Precedent 
Library should be visible for all Matters, select “Any.” 
 

3. Save and close the folder 

The new Precedent Library will now appear in the list. 

Organise the precedent libraries in a way that best suits the firm’s workflow. Here is an example of how this 
can look: 
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Email Precedents 

 

Introduction 

 
Email precedents are a special type of precedent that create emails (via Outlook) rather than documents.  
The precedents themselves are simply Word documents (.docx) that sit in a precedent library configured to 
contain email precedents – see the Precedent Libraries section for details on how to do this. 
 
Email precedents support many but not all of the create mode capabilities of document precedents, but 
none of the edit mode capabilities. The following table shows which capabilities are supported: 
 

  Precedent type 
Capability Mode Email Document 

Fields    

  Built-in fields Create   
  InfoSheet fields Create   
  Populate content control fields Create   
  Populate merge fields Create   
InfoSheets    
  Prompt InfoSheets Create   
  Clause/Fragment InfoSheets (on run precedent) Create   
  Clause/Fragment InfoSheets (manually insert clause) Edit   
Clauses/Fragments    

  Insert clause (chosen in InfoSheet) Create   
  Insert clause (OA INCLUDE) Create   
  Insert clause (inline picker) Edit   
  Insert clause (manually from menu) Edit   
  Remove paragraph (OA REMOVE) Create   
Signatures    
  Insert signature at cursor Edit   
  Insert signature at placeholder Edit   
Stationery – Headers & Footers    

  Apply default stationery (on run precedent) Create   
  Apply or clear stationery (manually from menu) Edit   
Stationery – StyleSheets    

  Apply styles from StyleSheet Edit   
 
Email Precedents have a couple of additional email-specific capabilities: 
 

+ Salutation field: Special merge field that takes the salutation from the New Email dialog 

+ Subject block: Ability to specify that the first paragraph of the precedent is to be used as the 
subject of the email 
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Executing Email Precedents 

 
There are two key scenarios: 
 

+ Select precedent before email creation: This is done via the New Email dialog 
 

 

Figure 50 

+ Select precedent after email creation: This will be the case when responding to an existing 
email. This is done via the “Insert Precedent” menu item in the email message window 

 

 

Figure 51 

Both methods will display a precedent selection dialog that shows email precedent libraries relevant to the 
selected party/matter. If no matter is currently selected, email precedent libraries configured for all fee types 
will be shown. If a matter is selected, then email precedent libraries configured for the fee type of the matter 
will also be shown. 
 

 

Figure 52 
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The precedent is selected by double-clicking, or selecting in the list and clicking “Open Precedent.” 
 

+ When using the “New Email” dialog, the selected precedent will populate into the “Email 
Precedent” field and will populate into the new email body when “Create Email” is clicked 

+ When using the “Insert Precedent” menu item in the Outlook message window, the selected 
precedent will immediately be inserted at the cursor 

 

Managing Email Precedents 

 
Email precedents are .docx files stored in the file system externally to OneLaw and exposed to OneLaw via 
Precedent Libraries.   
 
Precedent Libraries containing email precedents are configured by setting the Library Type to “Email” in the 
Precedent Library configuration: 
 

 

Figure 53 

For all other settings and a general overview of Precedent Libraries, see the Precedent Libraries section in 
this manual. 
 

Building Email Precedents 

 
Email precedents are stored as .docx files. They can optionally contain merge fields for built-in or InfoSheet 
fields, for both Matter and Prompt InfoSheets (see the InfoSheets section for more details). 
 

Creating a Simple Email Precedent 

At their simplest, email precedents don’t need to contain any fields or automation. They can just be a Word 
file whose contents will be copied into the body of the email when the precedent is run. 
 
To create a simple email precedent, create a document with Microsoft Word, insert the content that should 
be able to copy into an email, and save it as a .docx file to a folder referenced by an Email Precedent Library.  
The document shouldn’t contain headers/footers, sections, footnotes or other elements that aren’t 
supported by email. 
 
Once saved to the folder referenced by the precedent library, the precedent will appear in the Precedent 
Library in OneLaw and Outlook, and when executed, will copy the content of the document into the email. 
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Adding Fields 

Email precedents support merge fields and support most of the same merge fields as document precedents.  
See the Fields & Data section for more information about fields in general, and Document Field Differences 
by Precedent/Template Type for more information about exactly which fields are supported by email 
precedents. For more information about adding merge fields to a precedent, see Working with Merge Fields.   
 
If merge fields are to be used for an email precedent, follow the following steps: 
 

1. Ensure the precedent is attached to the firm’s OneLaw store. Do this by: 
a. With the precedent open, on the OneAuthor tab, click Attach/Repair 
b. Select Current Document 
c. Click the Attach/Repair button 

NOTE: This step only needs to be done once per precedent 
2. If InfoSheet fields are to be included, attach the InfoSheets to the document. For details on how to 

do this, see   
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3. Attaching InfoSheets to Documents. Both Matter InfoSheets and Prompt InfoSheets are supported 
4. On the OneAuthor tab, click Merge Field Names. This will open a new Word document containing 

merge fields for all the available built-in and InfoSheet fields 
5. Copy and paste the required merge fields from the Merge Field Names document into the precedent 

 

Including a Subject Line 

An email precedent can define what the contents of the email subject should be. To specify a subject, start 
the first paragraph of the precedent document with “Subject:”. This identifies the first paragraph as 
specifying the subject. 
 
NOTE: The subject line will only be used when creating new emails with the New Email button. When adding 
a precedent to a response email (reply/forward), by using the Insert Precedent button in Outlook, any 
subject defined in the precedent will be ignored, and the existing subject of the email chain will be retained. 
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InfoSheets 

 

Introduction 

 
InfoSheets are designed to store specific or additional information in OneLaw and to be used for document 
assembly. The purpose of InfoSheets is to save time and assist with consistency across matters and their 
related documents.  
 
Examples where these can be useful include: 
 

+ Storing key dates and information for conveyancing matters 

+ Store details of estates or trusts 

+ Store clause details for will creation 

+ Act as an electronic checklist for specific fee types 
 
Within each of these examples, these details can then be pulled into precedents or templates. 
 
There are three types of InfoSheets available in OneLaw: Matter, Prompt and Fragment/Clause. 
 

+ Matter InfoSheets: Capture and store matter specific data and are located on a matter in 
OneLaw. Matter InfoSheets can be assigned to a gee type or to “ANY” matters. There is also a 
check box option to automatically attach the Matter InfoSheet when creating matters with a 
matching fee type 

+ Prompt InfoSheets: Capture document-specific data and prompt users with a dialog when 
executing a precedent 

+ Fragment/Clause InfoSheets: Capture fragment/clause-specific data and prompt users with a 
dialog when inserting a fragment/clause into a precedent 

 

InfoSheet Field Types 

 
The below explains what each field type is in an InfoSheet and gives examples of what the user will see when 
filling out an InfoSheet, whether it be a Matter, Prompt or Fragment/Clause InfoSheet. 
 

+ Heading: Headings are shown in bold and can be used to separate fields and outline sections. 
The Figure below shows the user’s view 
 

 

Figure 54 
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+ Single Line Text: Users type the relevant information into the text box. The Figure below shows 
the user’s view 
 

 

Figure 55 

 

+ Multi Line Text. Users type the relevant information into the text box. The Figure below shows 
the user’s view 
 

 

Figure 56 

 

+ Check Box: Users check the box if and when it’s required to be ticked. The Figure below shows 
the user’s view 
 

 

Figure 57 
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+ Choice List: Users select the appropriate choice from the options provided. The Figures below 
show the user’s view 

 

 

Figure 58 – Choice List Field as a drop down list 

 

 

Figure 59 – Choice List Field as horizontal radio buttons 

 

 

Figure 60 – Choice List Field as vertical radio buttons 

 

+ Date: Users choose a date from the date selector. The Figure below shows the user’s view 
 

 

Figure 61 

 

+ Number: Users type the relevant numbers into the text box. The Figure below shows the user’s 
view 
 

 

Figure 62 
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+ Money: Users type the relevant dollar amount into the text box. The Figure below shows the 
user’s view 
 

 

Figure 63 

 

+ Party Selector: Users select a client or non-client party from the Party Selector which is 
searchable across all parties in OneLaw. The Figure below shows the user’s view 
 

 

 

Figure 64 

 

+ Matter Selector: Users select a matter from the Matter Selector which is searchable across all 
parties in OneLaw. The Figure below shows the user’s view 
 

 

Figure 65 

 

+ Document Selector: Users can select a document which keeps a copy of that document on the 
InfoSheet. This Document Selector is searchable across all documents in OneLaw. The Figure 
below shows the user’s view 
 

 

Figure 66 
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+ Fragment Selector: Users select the appropriate fragment or clause from the options 
provided, for inclusion in a precedent. The Figure below shows the user’s view 
 

 

Figure 67 
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Applying InfoSheets to a Matter 

 
When setting up a matter, InfoSheets can be automatically attached to a matter if the InfoSheet has been set 
up to do so, or users can attach InfoSheets manually. To attach an InfoSheet manually, simply select the 
InfoSheet tab in the Edit Matter screen and check the InfoSheet required to be attached to the new matter. 
Once the matter has been saved, the InfoSheet will be displayed in the InfoSheet tab on the matter. 

 

Figure 68 

 

Figure 69 
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Editing InfoSheet on a Matter 

Users need to enter relevant information into an InfoSheet once the InfoSheet is attached to a matter. To do 

this, either double-click on the InfoSheet or select the Edit button in the InfoSheets tab. Users will then be 

able to enter the relevant information into the fields and save these by clicking Save & Close. 

 

 

Figure 70 

 

Figure 71 
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Adding and Removing InfoSheets 

InfoSheets can be added or removed from a matter at any time by clicking Select under the InfoSheets tab at 
the matter level. Users can also remove InfoSheets from a matter by unticking the InfoSheet in the Edit 
Matter screen. If an InfoSheet is removed from a matter, any associated data that has been entered into the 
InfoSheet will be deleted and is not recoverable. 
 

 

Figure 72 

 

Figure 73  
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Creating and Editing InfoSheets 

 
When selecting InfoSheets from the Administration tab in OneLaw, administrators can edit existing 
InfoSheets or create new InfoSheets. When editing an existing InfoSheet, simply double-click on the 
InfoSheet or highlight the InfoSheet in the list and click on the grey cog in the top right corner. 
 

 

Figure 74 

When creating a new InfoSheet, administrators can select the green plus icon. 
 

 

Figure 75 

Administrators will be presented with the Create InfoSheet dialog (see Figure below) with the following fields 
to complete: 
 

+ Name: Enter the name of the InfoSheet e.g. Purchase, Sale, Will etc 

+ Field Code Prefix: This will auto-fill with the name given to the InfoSheet 

+ InfoSheet Type: There are three types of InfoSheets available: 
+ Matter: These will show at the matter level under a new tab called InfoSheets where 

these can be viewed and/or edited 
+ Prompt: These types of InfoSheets can be attached to a document template and act as 

a questionnaire. Using this type will prompt users when creating a document from a 
OneAuthor template to complete fields, which details will then follow into the 
document 

+ Clause/Fragment: These types of InfoSheets can be attached to a clause or fragment 
document and act as a questionnaire. Using this type will prompt users when inserting 
a clause or fragment into a document to complete additional fields, which details will 
then follow into the document 

+ Fee Types: Users can select None, Any or multiple fee types for any InfoSheet, together with the 
option to automatically attach these when a matter with a matching fee type is created 
 

 

Figure 76 
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Adding Fields to InfoSheets 

 
Administrators can add fields by selecting the green plus icon. 
 

 

Figure 77 

When this is selected, administrators will be presented with the New Field dialog. The following fields are 
available: 

 

Figure 78 

+ Field Type: Select the type of field 

+ Field Name: Name this what the firm would like displayed for users to complete e.g. Property 
Address 

+ Field Code: This will automatically populate with the details from the Field Name above 

+ Is Required: Selecting this tick box will make this required to be completed by users 

+ Description: This multi-line text box will allow users to include large portions of text 

+ Show Description As: This option is to show the description as either a Tool Tip (when a user 
hovers over the field the description will show) or as inline text (the description will show in line 
with the field) 

 

 

Figure 79 

 

 

Figure 80 
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NOTE: When using the inline text option for headings, the description will show below the heading. 
 

 

Figure 81 

 

Field Types for Administrators 

The below explains what each field type is and gives examples of how it can be used in the InfoSheet. 
 

+ Heading: Headings are shown in bold and can be used to separate fields and outline sections. 
The Figure below shows the admin creation of a Heading 
 

 

Figure 82 

+ Single Line Text: We suggest using this field for short text information such as a property 
address or email address. Administrators can also provide predefined choice options for users. 
These predefined options will appear as a drop-down list. The Figure below shows the admin 
creation of a Single Line Text Field  
 

 

Figure 83 

 

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

49 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

+ Multi Line Text: A suggestion is to use this field for longer pieces of information such as a 
chattels list or entering full clauses as required. The Figure below shows the admin creation of a 
Multi Line Text Field 
 

 

Figure 84 

+ Check Box: This field can be used for questions of a yes or no nature. The Figure below shows 
the admin creation of a Check Box 
 

 

Figure 85 

+ Choice List: This field has several layout options, including drop-down selection lists and radio 
buttons. We would suggest using this field type in a scenario where there are multiple options 
for a question to be answered e.g. the age beneficiaries will receive their inheritance: 18,21, 25 
etc.  
 
Choice Lists can also have up to 5 additional values per choice. Useful examples of this would be 
if users wanted to include gender words (ie. for Female use have she, her, herself) or if users 
wanted to include different clauses. NOTE: if users want to include clauses in these values, users 
need to use OA INCLUDE and then the file location path (ie. OA INCLUDE C:\OneAuthor\Clauses). 
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The first two Figures below show the admin creation of a Choice List, and the following three Figures show 
the different views available for the Choice Lists. 
 

 

Figure 86 

 

Figure 87 

 

Figure 88 – Choice List field as a drop-down list 

 

Figure 89 – Choice List field as horizontal radio buttons 

 

Figure 90 - Choice List field as vertical radio buttons 
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+ Date: This will create a date selector. The Figure below shows the admin creation of a Date Field  
 

 

Figure 91 

+ Number: This field can be used for numbers, such as the late interest amount on a contract. The 
Figure below shows the admin creation of a Number Field  
 

 

Figure 92 

+ Money: This field will populate with a dollar sign, allowing for fields such as purchase price and 
deposit to be displayed as a dollar amount. The Figure below shows the admin creation of a 
Money Field  
 

 

Figure 93 

+ Party Selector: This will create a party selector which is searchable across all parties in OneLaw. 
The Figure below shows the admin creation of a Party Selector  
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Figure 94 

+ Matter Selector: This will create a Matter Selector which is searchable across all matters in 
OneLaw. The Figure below shows the admin creation of a Matter Selector 
 

 

Figure 95 

+ Document Selector: This will create a document selector which is searchable across all 
documents in OneLaw. The Figure below shows the admin creation of a Document Selector 
 

 

Figure 96 

 
 
 

+ Fragment Selector: This will create a Fragment Selector that will support a selection of 
clauses and fragments to include in a Precedent. For more information see the InfoSheet 
Fragment Selector section. The Figure below shows the admin creation of a Fragment 
Selector 
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Figure 97 

Order of Fields 

Fields can be re-ordered by using the green arrows to the right of the Edit InfoSheet dialog box, or simply 
drag and drop the fields to re-order them. 
 

Right-click Menu 

There is a menu available for making edits when right-clicking on a field. The following options are available: 
 

+ Edit 

+ Insert New Field Above 

+ Insert New Field Below 

+ Delete 
 

  

Figure 98 
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Attaching InfoSheets to Documents 

 

Adding InfoSheets to Existing Templates 

To add an InfoSheet to an existing template, select the OneAuthor tab in Word and edit the existing template.  
Once in edit mode, under the OneAuthor tab, click on InfoSheets and select the InfoSheet that needs to be 
attached. Please note that multiple InfoSheets can be attached to the template. 
 
Once the InfoSheet has been added to the template, you will need to map the fields as per existing 
templates. 
 

 

Figure 99 

 

Adding InfoSheets to New Templates and Precedents 

You can add InfoSheets to new templates, precedents and clauses and fragments in the same way that you 
would an existing template. Once you have created a new document, navigate to the OneAuthor tab and 
select InfoSheets. Click on the green plus and select the InfoSheets you want to add to the document. As per 
above, you can add multiple InfoSheets to a single document. 
 
NOTE: Matter and Prompt InfoSheets can only be added to documents already configured as OneLaw 
templates/precedents – see Documents & Precedents for more information. 
 

 

Figure 100 

  

Removing InfoSheets from Documents 

To remove an InfoSheet from a document, navigate to the OneAuthor tab in Word and select InfoSheets.  
Click the red minus and remove the desired InfoSheet.  
 

 

Figure 101 
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Using Prompt InfoSheets 

Prompt InfoSheets are attached directly to a precedent (not at matter level) and intended to be used like a 
questionnaire or interview for the document itself. This prompts users to enter document specific 
information. 
 
To create a Prompt InfoSheet, do this the same way as you would a matter level InfoSheet. 
 

 

Figure 102 

You will need to choose Prompt for the InfoSheet Type. 
 

 

Figure 103 

After you have created and saved your prompt InfoSheet in OneLaw, you can now add this to the precedent it 
was designed for. This can be done in the same way as any other type of InfoSheet. 
 

 

Figure 104 

Once the InfoSheet has been added to the precedent or template, the fields will be available to be added as 
merge fields or content controls. For more information, see the Working with Merge Fields and Working with 
Content Controls sections.  
 

  

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

56 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

Using Clause/Fragment InfoSheets 

Clause/Fragment InfoSheets are attached directly to a clause or fragment document and intended to be used 
like a questionnaire or interview for the clause or fragment itself. This prompts users for document specific 
information. 
 
To create a Clause/Fragment InfoSheet, complete the same steps used when creating a matter level 
InfoSheet and select Clause/Fragment for the InfoSheet type.  
 

 

Figure 105 

 

Figure 106 

After the Clause/Fragment InfoSheet has been created and saved in OneLaw, this can be added to the clause 
or fragment document it was designed for. This can be done in the same way as any other type of InfoSheet. 
 

 

Figure 107 

Once you have added the InfoSheet to the clause or fragment document, the fields need to be mapped. 
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Mapping Fields 

 
Mapping OneLaw and InfoSheet fields can be done in two ways: either by using merge fields or by using 
content controls. 
 

Mapping Fields using Merge Fields 

Navigate to the OneAuthor tab in Word and select Merge Field Names. A new Word document will open with 
all the available merge fields that can be added to the document. All OneLaw fields will show first with the 
prefix “OP.”. All InfoSheet fields available for this document will show last with the prefix of the InfoSheet. 
 

 

Figure 108 

 

Figure 109 

Copy and paste the fields necessary into the document. 
 
For more information, see the Working with Merge Fields section below. 
 

Mapping Fields using Content Controls 

Navigate to the OneAuthor tab in Word and select Editor. Once selected, the XML Mapping menu will appear 
on the right side of the screen. Use the drop-down list to choose either OneLaw fields or InfoSheet fields that 
may be attached to the document. 
 

 

Figure 110 
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Figure 111 

 

Next, drag and drop the content control field into the document. 
 
For more information, see the Working with Content Controls section below. 
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Fields & Data 

Introduction 

 
Fields are placeholders in documents that get replaced/populated with values from OneLaw, or 
Fragments/Clauses, upon document assembly. 
 
OneLaw supports two types of fields: 
 

+ Content controls: These are rich in-document objects that bind on to data embedded into the 
document. They come in multiple types, including plain text and date pickers. When the value in 
a content control is updated, the underlying data is also updated, and any other content controls 
bound to the same data field also update immediately. The underlying data is stored in the 
document as “Custom XML Parts,” which is a Microsoft technology for embedding data into 
documents 

+ Merge fields: These are field codes that get replaced by content during the document assembly 
process, leaving just the resulting text in the document 

 
Key differences between content controls and merge fields are as follows: 
 

Aspect Content controls Merge fields 

Basic principle Binds on to data embedded in the 
document 

Replaced by data during document 
assembly process 

Lifecycle Remain in document after document 
assembly process 

Only resulting text remains after 
document assembly fields are removed 

Formatting Content controls support formatting 
including specifying date format 

Merge fields support formatting 
including specifying date format 

Editing in finished 
document 

Modifying contents of a content 
control updates the underlying 
embedded data, which in turn 
updates any other content controls 
bound onto the same data field 

Only resulting text remains in 
document, so editing the text is like 
editing any other text 

Data support Supports built-In and InfoSheet data 
fields, does not support InfoSheet 
fragment/clause fields 

Supports built-In and InfoSheet data 
and fragment/clause fields 

Automation support Supported in Partial Automation 
(Word document) and Full 
Automation (Word template) 
precedents 

Only supported in Full Automation 
(Word template) precedents with the 
“Template uses MergeFields” setting 
enabled 

Word field code support Cannot interact with Word field 
codes (e.g. IF fields) 

Can be combined with other Word field 
codes (e.g. IF fields), allowing simple 
programmability within the precedent 

 
Field data can come from the following field sources: 
 

+ Built-in: This is data from the party, patter and user records in OneLaw, as linked to the 
document via party, matter, recipient,oOffice, operator and author fields on the document. 
Built-in fields are described in the next section, Built-In Field Data 

+ InfoSheets: This is data from custom fields defined on InfoSheets, either attached to a matter or 
displayed as a dialog when assembling a document. InfoSheets are described in the InfoSheets 
section  
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Built-In Field Data 

 
There is a comprehensive set of built-in fields available for mapping into precedents. It is also possible to 
define custom fields via InfoSheets, described in the   
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InfoSheets section. 
 
The key types of data objects available via built-in fields are: 
 

+ Document 

+ Party 

+ Matter 

+ User 

+ Address 
 
The available fields for these are outlined below.  
 
NOTE: Where a type is asterisked *, this means it refers to another data object type outlined in this section. 
 

Document 

This is the root data object for built-in data within any OneLaw precedent. 
 

Field Name Type Note 

FirmId Guid The firms’ unique identifier 

DocumentId Text (ID) The Id of the document in OneLaw, including the version 
number 

VersionNote Text The user entered note when creating a new version of a 
document 

CreationDateTime DateTime The date and time the precedent was executed, or the 
document was managed into OneLaw 

LastUpDatedDateTime DateTime The date and time the document was last managed to 
OneLaw 

DocumentDate Date The date the precedent was executed, or the document was 
managed into OneLaw 

DocumentName Text The user provided name for the document 

DocumentType Text Word document or Word template 

TemplateId Guid (Legacy – ignore) 

Operator User* The user logged into OneLaw who executed the precedent or 
managed the document 

Author User* The user selected Author for the document 

Office Party* The user selected Office for the document  

Client Party* The user selected Party or Client. Can be a non-client party 

Matter Matter* The user selected Matter for the document, can be not 
populated if the document is to be managed to the Party 

Recipient Party* The user selected document recipient 

Categories CategoryList A list of selected categories on the document.   
NOTE: This is work in progress and not fully functioning 
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Party 

This data object represents a client or party, including users and offices (special types of parties in OneLaw).   
 

Field Name Type Note 

PartyId Text (ID) Internal Id, do not use 

FullName Text  

MailingName Text  

Salutation Text  

IsPerson True/False True if the party type is Natural, false if it is any other type 
(e.g. multi, legal, office) 

Title Text  

FirstName Text  

MiddleNames Text  

LastName Text  

Suffix Text  

KnownAsName Text  

Occupation Text  

Employer Text  

ClientId Text (ID) Internal Id, do not use 

ClientNumber Text  

PhysicalAddress Address*  

PostalAddress Address*  

BillingAddress Address*  

DXAddress Address*  

RegisteredOfficeAddress Address*  

OverseasAddress Address*  

Email Text  

AREmail Text  

Phone Text  

Mobile Text  

Fax Text  

IsTaxResident True/False  

GstNumber Text  

BankAccountNumber Text  

BankAccountName Text  

IsInactiveClient True/False  

IsCreditStopped True/False  

IsCDDRequired True/False  

DateOfBirth Date  

DateOfDeath Date  

DateOfProbate Date  

ClientAuthor User* The ‘Supervising Author’ configured on the client 
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Matter 

This data object represents a matter in OneLaw. 
 

Field Name Type Note 

PartyId Text (ID) Internal Id, do not use 

ClientId Text (ID) Internal Id, do not use 

MatterId Text (ID) Internal Id, do not use 

Name Text  

ClientNumber Text  

MatterNumber Integer  

IsConfidential True/False  

EstimatedFees Money  

EstimatedCostsAndDisbursements Money  

CounterParty Party*  

CounterPartyFirmActing Party*  

CounterPartyLawyerActing Party*  

InstructingParty Party*  

BillingParty Party*  

ARContact Party*  

IsActive True/False  

IsCapturedActivity True/False  

MatterAuthor User* The ‘Supervising Author’ configured on the 
matter 

 

User 

This data object represents a OneLaw user, used for Operator and Author on the document. 
 

Field Name Type Note 

UserId Text (ID) Internal Id, do not use 

Party Party* The Party record for the user – most information is here 

UserName Text  

Initials Text  

OfficePartyId Text (ID) Internal Id, do not use 

OfficeName Text  

AuthorRole Text  
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Address 

This data object represents an address in OneLaw. 
 

Field Name Type Note 

Line Text  

MultiLine Text  

Line1 Text  

Line2 Text  

Line3 Text  

Line4 Text  

Line5 Text  

Line6 Text  

Line7 Text  

Line8 Text  
Line9 Text  
SingleLine Text  
SingleLineCsv Text  
PostCode Text  

 

Document Field Differences by Precedent/Template Type 

The built-In fields are used for multiple Precedent types: 
 

+ Document precedents 

+ Email precedents 

+ Invoice/Statement templates 
 
Exactly which fields are populated varies by precedent type. The table below outlines which document fields 
are populated by precedent type. 
 

Field Name Document Precedent Email Precedent Invoice/Statement 
Template 

FirmId    

DocumentId    

VersionNote    

CreationDateTime    

LastUpDatedDateTime    

DocumentDate    

DocumentName    

DocumentType    

TemplateId    

Operator    
Author  (Set to Operator) (Set to Operator) 

Office  (Set to Office of Operator) (Set to Office of Operator) 

Client    
Matter    
Recipient    

Categories    
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Working with Content Controls 

 
Content controls are rich in-document objects that bind to data embedded into the document. They come in 
multiple types, including plain text and date pickers. When the value in a content control is updated, the 
underlying data is also updated, and any other content controls bound to the same data field also update 
immediately. 
 
The underlying data is stored in the document as “Custom XML Parts,” which is a Microsoft technology for 
embedding data into documents. The OneLaw software provides a set of tools to view the Custom XML Parts, 
insert content controls into a precedent that are bound to fields in the Custom XML Parts and check and 
repair the data binding on the content controls. 
 

Viewing OneLaw Fields in Custom XML Parts 

To view the Custom XML Parts, on the OneAuthor tab, click Editor: 
 

 

Figure 112 

This will show the XML Mapping pane docked to the right-hand side of the Word window: 
 

 

Figure 113 

The Custom XML Parts in the document are available in the XML Part drop-down list. This includes some 
Word built-in XML Parts that have no relevance for OneLaw, the OneAuthor Base Document Schema, which 
contains all the OneLaw built-in fields, and XML Parts for any InfoSheets attached to the document containing 
any InfoSheet fields: 

 

Figure 114 
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By selecting OneAuthor Base Document Schema, a tree containing all available OneLaw built-in fields will be 
shown. It is possible to drill down into this tree to get to fields on linked data, i.e. fields on the client or 
matter relating to the document. 
 
By selecting an InfoSheet, the fields for that InfoSheet will be available to use. Again, when the InfoSheet 
fields are links to parties, clients or matters, it is possible to drill down on those fields on the tree to access 
the fields on the linked data. For more information on InfoSheets, see the InfoSheets section. 
 
Below are examples showing the OneAuthor Base Document Schema and an example InfoSheet: 
 

 

Figure 115   

NOTE: 

+ The root (first) node in the tree for built-in fields will always be “DocumentMetaData.” The root 
(first) node for InfoSheets will always be “CustomData.” If the tree does not start with one of 
those items, then you are not looking at OneLaw fields as covered in this manual 

+ When authoring a template, the fields in the trees may contain dummy data or no data. This is 
replaced with real data when a precedent is executed 
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Inserting Content Controls 

Inserting content controls for OneLaw fields is done with a drag-drop operation, by dragging a field from the 
XML Mapping area to the body of the document. The insertable fields have the white icon, not the yellow 
folder icon. 

 
For example, drag: 

 

Figure 116 

Drop: 

 

Figure 117 

We now have a date content control in the document bound to the Settlement Date field in the Residential 
InfoSheet. As it is a precedent, it will show dummy data. 
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Checking and Relinking Content Controls 

The easiest way to check that a content control is correctly linked to the desired OneLaw field is to click on it 
with the XML Mapping pane open. If the content control is linked to a field, it will switch to the correct XML 
Part (built-in or InfoSheet) and highlight the field the content control is linked to. If this does not happen, the 
field is not linked correctly. See the Viewing OneLaw Fields in Custom XML Parts section for information on 
how to show the XML Mapping pane. 
 
Another way to check is to click on the content control, then click the Content Control Properties button 
within the OneAuthor tab: 
 

 

Figure 118 

 

This will display a message that either shows a mapping to the XML Part (via an ‘XPath’ expression) or that 
the content control is not mapped. For example, a correctly linked content control will produce a message 
such as: 
 

 

Figure 119 

A content control that is not correctly linked will produce a message such as: 
 

 

Figure 120 

To relink an unlinked content control, click on the content control, then in the XML Mapping pane, right-click 
the field you want to link to, and click “Map to Content Control.” 
 
 
 
 

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

69 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

Specifying Content Control Formatting 

For date content controls, you may want to specify the desired formatting for the date, for example, “22 June 
2025” instead of “22/06/25.”  The date format can be specified in the Content Control Properties dialog.  
Click into the content control, then on the Developer tab and click Properties.  
 

 

Figure 121 

 

This will show the Content Control Properties dialog, where the date format can be set: 
 

 

Figure 122 

The same principle holds for other field types that can have different formatting, such as numeric or currency 
values. 

  

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

70 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

Working with Merge Fields 

 
Merge Fields are a built-in Word field type that gets replaced with a field value during the document 
assembly process. After this process, the merge field no longer exists in the document, only the resulting 
value. Within the OneLaw document assembly process, a merge field can resolve to a simple field value, or 
Fragment/Clause related tag that in turn resolves into a Fragment or Clause.  
 
For more information on the Fragment/Clause scenarios, see the Clauses/Fragments section. This section 
focuses on simple field values including text, date, number etc. 
 
Like all Word fields, merge fields have 2 view modes – instruction mode and result mode. See below for an 
example of how a merge field looks in the different modes: 
 

Mode Example 
Result «OP.Client.FullName» 

Instruction { MERGEFIELD OP.Client.FullName \* MERGEFORMAT } 

 
NOTE: The bolded brackets {  } in the instruction mode are not simply brackets, they are special Word field 
delimiters. 
 
The following key commands can be used to work with merge fields (and all Word fields): 
 

+ F9: Refresh the field result (i.e. update the result mode with changes made in the instruction 
mode) 

+ Shift + F9: Toggle a field between result mode and instruction mode 

+ Alt + F9: Toggle all fields in the document between result mode and instruction mode 

+ Ctrl + F9: Insert a new empty field  (This will be inserted in instruction mode, and will look like 
this: {  }. ) 
 

It is also possible to refresh or toggle a field using the right-click menu on the field: 
 

 

Figure 123 
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OneLaw Merge Field Naming 

Merge fields in OneLaw follow a convention-based naming scheme: 
 

+ All built-in fields start with “OP.”  Simple document fields like Document Date have a name like 
“OP.DocumentDate” 

+ Fields on linked data (such as client or matter) use a dot “.” to separate each level in the field 
name – e.g. “OP.Matter.Name” 

+ All InfoSheet fields start with the Field Code Prefix of the InfoSheet. For example, all fields for 
the below InfoSheet will start with “Residential” 

 

         

Figure 124 

+ InfoSheet field names use the Field Code defined on the field. For example, using the same 
InfoSheet as above, the “Agreement Date” field is defined Agreement Date. The merge field 
name will be “Residential.Agreement-Date” 

 

         

Figure 125 
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 Viewing All Available Merge Fields 

In any OneLaw precedent, you can access all available merge fields, built-in and for any attached InfoSheets, 
by clicking Merge Field Names on the OneAuthor tab: 
 

 

Figure 126 

This will open a new Word document containing merge fields for all available fields. As there are many 
available fields, this document is many pages long: 
 

 

Figure 127 

All the built-in fields come first, followed by the attached InfoSheet fields. 
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Inserting Merge Fields 

There are multiple ways to insert a merge field in a precedent: 
 

+ Within the Word Insert tab, click “Quick Parts”, then “Field…”.  This will show the Word Field 
dialog. Select “MergeField,” enter the name of the field (per the naming conventions here: 
 OneLaw Merge Field Naming 

 

Figure 128 

+ Manually insert a field using Ctrl + F9, then type the merge field code into the new field. This 
should be something like: { MERGEFIELD OP.Client.FullName \* MERGEFORMAT } 

+ Copy and paste the merge field from the Merge Field Names document described above. It is 
best to use the Word paste option “Merge Formatting,” available from the Paste button on the 
toolbar (shown below). This is the easiest and recommended way to insert merge fields 

 

Figure 129 

Formatting Merge Fields 

The basics of formatting a merge field work by using the controls in the Font section of the Home tab in 
Word. These include bolding, italicising, underlining, changing font and colour etc. For more complex 
formatting, such as capitalising or changing date formats, see the article from Microsoft here.  
 
The examples below show how a date merge field looks from the Merge Field Names list. We want to 
reformat it so that it reads as: day MONTH year being 1 January 2025. We add in the syntax \@ “d MMMM 
yyyy” – you can find other formats here. 
 

 

Figure 130 
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Conditional Logic with IF Fields 

 
When using merge fields, it is possible to combine these with Word IF fields to conditionally include text or 
other fields in a document. Some scenarios where this can be useful are as follows: 
 

+ Include some text when a field contains a specific value.  e.g. include the word ‘her’ when a 
Gender field contains ‘Female’ 

+ Include a default value when a field contains no value 

+ Include the value of another field when a field contains a specific value 

+ Remove a paragraph when a field contains no value. NOTE: This utilises a special OneLaw feature 
‘OA REMOVE’.  e.g. remove a fax number line (paragraph) when the fax number field is not 
populated 

+ Include a clause contained in another document when a field contains a specific value 
 
NOTE: Many of the solutions outlined in this section can be achieved using other OneLaw capabilities. For 
example, Choice Fields in InfoSheets can be used to specify additional gender pronouns on a Gender field, 
and Fragment Selector fields in InfoSheets are often an easier solution for selecting clauses. Where other 
solutions exist, IF fields should be a fallback solution. Preferred solutions will be outlined below. 
 

IF Fields Overview 

IF fields take the form {IF “Expression1” Operator “Expression2” “TrueValue” “FalseValue”}. 
 
Expression1 and Expression2 should be surrounded by quotation marks as shown above. They can be text 
values, merge fields or numbers. 
 
Operator can be one of the following: 

Operator Description 

= Equal to 
<> Not equal to 

> Greater than 

< Less than 
>= Greater than or equal to 

<= Less than or equal to 

 
TrueValue and FalseValue represent the content that will be included in the document when the comparison 
is either true or false. 
 
There are two ways to insert an IF Field. The first is via the Quick Parts on the Insert tab in Word: 
 

 

Figure 131 
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This opens the field selector dialog, where you can type the contents of the IF field. 
 

 

Figure 132 

An easier and preferable method is to do the following (assuming an ‘=’ comparison): 
 

1. In the document in the location for the IF field, type Ctrl + F9.  This inserts an empty field that will 
look like this: {  }  

2. Inside the field insert the following: {IF “” = “” “” “”}. This puts the structure of the IF field in place, 
with all the required quotes 

3. Inside the first quotes, paste the merge field you want to compare to, e.g.: 
{IF “«MyInfoSheet.Gender»” = “” “” “”} 

4. Inside the second quotes, add the value you want to compare to, e.g.: 
{IF “«MyInfoSheet.Gender»” = “Female” “” “”} 

5. Now fill in the TrueValue and FalseValue expressions: 
{IF “«MyInfoSheet.Gender»” = “Female” “her” “his”} 

6. IF fields can be nested where there are more than 2 options you want to consider, e.g.: 
{IF “«MyInfoSheet.Gender»” = “Female” “her” “{IF “«MyInfoSheet.Gender»” = “Male” “his” 
“their”}”} 
NOTE: It is strongly recommended to avoid deeply nested IF statements as these can be very hard to 
read, understand and maintain. 

7. The field can be toggled between the edit view above and the result view using Shift + F9. In the case 
when comparing a merge field to a value, this will always evaluate to false prior to executing the 
template, so the FalseValue will always show in the results view 
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Scenarios 

A number of specific scenarios are outlined below to illustrate the types of solutions that IF Fields led 
themselves to. There are many more scenarios where IF Fields may be a good option. 

Include Text When a Field Contains a Specific Value 

In this case, the field will look something like {IF “«MyInfoSheet.Gender»” = “Female” “her” “his”}. 
 
Where the field is an InfoSheet CheckBox field, the possible values are “true” and “false,” all lowercase.  E.g.: 
{IF “«MyInfoSheet.IsFemale»” = “true” “her” “his”}. 
 
NOTE: Where the field is an InfoSheet Choice Field, it is almost always preferable to avoid IF fields by using 
the additional values on the Choice Field values. For example, a choice field ‘Gender’ might have 3 values, 
Male, Female and Non-binary. We can attach up to 5 additional values to each Choice Field value, which 
might be as follows: 
 

Value Male Female Non-binary 

Additional Value 1 he she they 

Additional Value 2 him her them 

Additional Value 3 his her their 

Additional Value 4 his hers theirs 

Additional Value 5 himself herself themself 
 
These additional fields are available directly as merge fields, avoiding the need to use IF fields in this case. 
For more information, see the Field Types section. 
 

Include Another Field Value When a Field Contains a Specific Value 

In this case, we might see something like: 
{IF “«MyInfoSheet.ShowParty2»” = “true” “«MyInfoSheet.Party2.Name»” “”}. 
 

Specify a Default Value if a Field is Not Populated 

In this case, we might see something like: 
{IF “«MyInfoSheet.ReviewDate»” = “” “[Specify Review Date]” “«MyInfoSheet.ReviewDate»”}. 
 

Remove a Line/Paragraph if a Field is Not Populated 

OneLaw specifies some special tags that can be used in documents to support various clause insertion 
scenarios. One of these tags can also be used to remove paragraphs when a field contains no value. This 
avoids leaving an empty line. 
 
This tag is: {{OA REMOVE PARAGRAPH}} 
NOTE: The braces in this case do not indicate a Word field object – they are just text. 
 
For example, consider we have a fax number line that we want to show when the fax field is populated, but 
we want the entire line to be removed if there is no fax number specified. In this case we might have a field 
like: 
 
{IF “«OP.Client.Fax»” = “” “” “Fax Number: «OP.Client.Fax»”}. 
 
This has the net effect of not showing the Fax Number line when the Fax field is not populated, but it still 
leaves a blank line. To also remove the blank line, we can use the OA REMOVE tag as follows:  
 
{IF “«OP.Client.Fax»” = “” “{{OA REMOVE PARAGRAPH}}” “Fax Number: «OP.Client.Fax»”}. 
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Now when the precedent is executed, if the fax field is empty then the OA REMOVE tag is placed into the 
document, instructing the OneLaw software to remove the whole paragraph, including the trailing newline. 
 
NOTE: the OA REMOVE tag is only supported in document precedents, not email precedents or statement 
templates. 
 

Include a Clause When a Field Contains a Specific Value 

In this case, we might see something like: 
{IF “«MyInfoSheet.IncludeBequestClause»” = “true” “{{OA INCLUDE P:\Clauses\BequestClause.docx}}” “”}. 
 
This makes use of OA INCLUDE tags, which are covered fully in the OA INCLUDE tag section OA  
 
NOTE: the OA INCLUDE tag is only supported in document precedents, not email precedents or statement 
templates. 
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Bidirectional Data Flow 

 
Bidirectional data flow is an optional feature that allows changes to content controls bound to certain 
InfoSheet fields to be written back to the InfoSheet when the document is managed. 
 
This only supports simple field types – text, date, number and money. 
 
When this feature is enabled, if the user has modified any supported content control fields bound to an 
InfoSheet, then when the user manages the document to OneLaw, they will have the option to also push the 
data changes back to the InfoSheet: 
 

 

Figure 133 

 
NOTE: It is generally recommended that bidirectional data flow is disabled for firms unless the following 
points are all true: 
 

+ The firm does not use merge fields in its precedents 

+ The firm does not use complex InfoSheet field types (CheckBox, Choice Lists, etc.) 

+ The firm really wants this capability and understands it only applies to InfoSheet fields, not built-
in fields 

 
Unless all the above are true, then this capability can lead to user confusion due to inconsistent treatment of 
different field types. 
 
Please contact OneLaw support to request that this feature be enabled or disabled: support@onelaw.co.nz 
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Clauses/Fragments 

 

Introduction 

 
Clauses and fragments in OneLaw are documents whose contents can be inserted into another document.  
They are stored in .docx files, and the contents of the clause/fragment .docx file can be copied into another 
document – either automatically when executing a full automation precedent, or manually from the 
Fragments menu in Word. 
 
Clauses and fragments in OneLaw are very similar in concept but have some key differences. The table below 
outlines the similarities and differences: 
 

Feature Fragments Clauses 

File type .docx .docx 

Storage location Document templates in 
OneLaw 

In external folder, 
referenced by clause library 

Method of organisation Fragment categories Clause libraries, folders, 
subfolders 

Maximum file size 1Mb Unlimited 
Available in Fragments menu in Word? Always If clause library matches fee 

type of matter 

Nested Fields (content controls, merge 
fields) 

Yes Yes 

Clause/Fragment InfoSheets Yes Yes 

Nested clauses/fragments Yes Yes 

Nested clause pickers Yes Yes 
 
There are three ways clauses and fragments can be included in documents: 
 

+ Automatically inserted upon creation of a document from a precedent, either always or 
depending on selections made in InfoSheets 

+ Inserted based on selection in an inline clause selector that has been inserted upon creation of a 
document from a precedent 

+ Manually in any document, from the Fragments menu in the OneAuthor area of the Home tab in 
Word 
 

Style Considerations 

 
When building and using clauses and fragments, Word styles need to be considered. The process of inserting 
a clause or fragment is effectively inserting the contents of a source Word document (the clause or fragment) 
into a target Word document (the precedent or document). When Word performs this action, it needs to 
merge the styles of the source and target.  
 
With clauses and fragments, style priority is always with the target, which means if the clause/fragment 
contains content in a style, and the precedent/document also has a style with that name, the style formatting 
in the precedent/document will be applied to the incoming content from the clause/fragment. 
 
 
 

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

80 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

Example scenario: 
 

+ A clause document defines the Normal text style as font Arial and contains content using Normal 
style with no paragraph or character font overrides 

+ A precedent defines Normal style as font Calibri 

+ When the clause is inserted into the precedent, the content in the clause using Normal style will 
appear as Calibri in the precedent rather than Arial, as the precedents’ Normal style will take 
precedence over the clause’s Normal style 
 

 

Manually Inserting Clauses and Fragments 

 

Fragments 

Under the Home tab in Word, select the Fragments tool.  
 

 

Figure 134 

The drop-down menu will show all firmwide Fragment Categories before the divider (indicated with the 
arrow). A divider will separate Fragment Categories from Clause Libraries, and will be present when both are 
available: 
 

 

Figure 135 

.Select the desired fragment category, and the fragment chooser will show: 
 

 

Figure 136 

Select Insert, and the fragment will insert at the cursor. 
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Clauses 

Under the Home tab in Word, select the Fragments tool.  

The drop-down menu will show all Clause Libraries available for the fee type of the matter selected for the 
document. These will show after the divider (indicated with the arrow below). The divider will separate 
Fragment Categories from Clause Libraries, and will be present when both are available: 
 

 

Figure 137 

When the Clause Library is selected, the clause picker will show: 
 

 

Figure 138 

 
Choose the Clause Folder (these are sub-folders in the clause library), then the clause on the right-hand side. 
When Insert is clicked, the selected clause will be inserted at the cursor. 
 
If a specified fee type has been assigned to the clause library, these clauses will only show in Word if the user 

is working on a matter with that specified fee type. If a clause library has been assigned to “ANY” fee type, 

then these clauses will be available in any Word document. 
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Managing Fragments 

 
Each fragment document gets uploaded as a document template to OneLaw. Currently, the maximum size for 
any document template is 1Mb. 
 
Once you have created a fragment document, save it somewhere accessible to OneLaw. 
 
Follow the steps below to upload the fragment document: 
 

1. Navigate to the Administration (or Templates) tab and select Document Templates: 
 

 

Figure 139 

2. In the Document Templates screen, find the OneAuthor Fragments section: 
 

 

Figure 140 

3. Click the (+) button. You will see the Fragment dialog box: 
 

 

Figure 141 

4. Specify the Category of the fragment. The Category defines what will appear in the Fragments menu 
in Word: 

Figure 142 
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5. Specify the name of the Fragment: 
 

 

Figure 143 

6. Click Browse, select the fragment document you saved earlier and click Save & Close 
 
Once fragments have been created, they can be edited from the OneAuthor Fragments section of the 
Document Templates screen. When editing, the Name and Category can be changed, and the fragment 
document can be re-uploaded. There is also an option to download the existing fragment document by 
clicking View. 
 

 

Figure 144 

 

Managing Clauses 

 
Navigate to the Administration tab in OneLaw and select Manage Libraries: 
 

 

Figure 145 

In the Manage Libraries screen, there is a Clause Libraries section. You can use the standard buttons at the 

top left to add, delete or modify Clause Libraries: 

 

Figure 146 

 

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

84 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

To create a new clause library, click on the green plus (+). A dialog will appear which requires the following: 
 

+ Name: Provide an appropriate name for the clause library, e.g. Will Clauses 

+ Folder: either manually enter the path to the external folder containing the necessary clause 
folder or select Choose Folder. This can contain subfolders, which can be referenced in clause 
selectors. If the folder is a SharePoint location, it will be mapped to the user profile of each user. 
In this case, use %USERPROFILE% so it’s not pointing to a specific user’s user profile. To do this, 
instead of C:\Users\a.user\OneLaw\Precedents, specify %USERPROFILE%\OneLaw\Precedents. 
The %USERPROFILE% tag will resolve to each user’s correct user profile path on their PC. 

+ Fee Types: Assign a fee type to the folder. This can be either a main fee type, a sub fee type, 
multi select across different fee and sub fee types, ANY (which means the clauses will be 
available across all fee types) or None. If None is selected, the clauses in the clause library won’t 
be available for users. This is a good option for when first creating a clause library and testing is 
required before finalising and releasing it to the firm. 
 

 

Figure 147 

 

Structuring Clause Libraries 

Organise clause libraries in an external folder that best suits the firm. This external folder should only be 
accessible to administrators and those with permission to maintain the content. 
 
See below for examples of how to structure clause libraries. There is no limit to how many folders and 
subfolders there can be. 

 

Figure 148 
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Creating a Clause/Fragment Document 

 
Clause and fragment documents are simply .docx files containing the content to be inserted into the 
precedent when the clause/fragment is inserted. Clauses and fragments can contain any content that would 
work in the target precedent. This includes text, content controls, merge fields and inline clause pickers. 
 
Generally, the clause/fragment documents need to be designed for the types of precedents they will be 
inserted in, with matching styles (see Style Considerations) and numbering. An exception is something like a 
terms sheet, which should use unique styles of its own, so there are no unexpected changes due to 
conflicting styles in the precedent. 
 
The easiest and most reliable way to create a clause/fragment document for a particular type of precedent is 
to have the required clause or fragment content correctly placed in the precedent document, then copy it to 
a new, clean document. This can be done by completing the following steps: 
 

1. Put all of the possible clauses for a particular clause selection into a copy of the precedent. Ensure 
that the styles and numbering are correct for all clauses throughout the precedent.  
 

 

Figure 149 
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3. Copy one clause at a time and paste it into a new document, ensuring the styles and numbering 
remain. NOTE: Numbering will restart. 

 

 

Figure 150 

 

Figure 151 

 

Figure 152 

4. Attach any necessary Clause/Fragment InfoSheets to the document and map required fields. 
 

5. Save the clauses separately as .docx files to an external clause library. NOTE: There can be an infinite 
number of clauses in the libraries, as well as subfolders. 

 

 

Figure 153 

 

6. Once the clause library is complete, upload the path to OneLaw. See  
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8. Managing Precedent Libraries for more information. 

Including Fragments/Clauses in Precedents 

 
There are multiple ways to include fragments/clauses in precedents: 
 

+ OA INCLUDE tag: A simple text tag that specifies a clause or fragment to include. These can be 
included directly in a precedent to include a shared piece of content that is reused across 
multiple documents – e.g. terms of service or disclaimer. OA INCLUDE tags can be used inside IF 
fields to provide simple conditional inclusion of clauses/fragments 

+ InfoSheet Choice fields: It is possible to set up InfoSheet Choice fields such that there is an 
additional value containing an OA INCLUDE tag. This allows the Choice field to specify specific 
clauses/fragments to be included when each choice value is selected 

+ InfoSheet fragment picker fields: These effectively work as an auto-populating choice field for 
fragments and clauses. For fragments, the picker will auto-populate with all fragments with a 
particular Category. For clauses, the picker will auto-populate with all clause files in a particular 
folder in a Clause Library. This can be the root folder of a Clause Library, or any subfolder nested 
beneath a Clause Library. These pickers automatically pick up new fragments matching the 
category, or clauses in the Clause Library folder 

+ Inline fragment pickers: These are auto-populating drop-down list style content controls added 
to the body of a document. They auto-populate in the same way as the InfoSheet Fragment 
Picker fields. When a clause/fragment is chosen in the picker, the picker is removed and replaced 
with the selected clause/fragment. There is an option to create repeating clauses, whereby the 
picker is not removed when a clause is selected, allowing a subsequent clause from the same list 
to be selected 

 
The remainder of this section provides details on how to use each of the above options. 
 

OA INCLUDE tag 

The primary method used by OneLaw to insert fragments and clauses into documents is the OA INCLUDE tag.  
This tag can be used directly in documents, in Word IF Fields, in InfoSheet Choice fields and underpins 
InfoSheet Fragment Pickers where the OA INCLUDE tags are generated automatically. 
 

OA INCLUDE tag overview 

An OA INCLUDE tag is structured like the following: 
{{OA INCLUDE PathToFragment Modifier}} 
 
The braces {{ and }} are simple text braces, not Word field delimiters. 
 
Modifier specifies an optional command to modify the behaviour of the OA INCLUDE tag. There is currently 
only one available modifier: “*NONEWLINE”. By default, when clauses or fragments are included, there is a 
trailing newline. This is desirable when bringing in an entire clause, but when inserting a fragment or clause 
into the middle of an existing paragraph, the trailing newline is most likely unwanted, in which case we can 
suppress it with the *NONEWLINE modifier. e.g. {{OA INCLUDE P:\Clauses\MyClause.docx *NONEWLINE}} 
 
PathToFragment specifies the location of the clause or fragment to be inserted. This points to a docx file in 
the file system, a Clause Library or a Fragment Category. The specified path must work for all. 
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The following list indicates how to specify PathToFragment for different scenarios: 
 

+ Clauses on shared drive: PathToFragment will simply be the full file path to the clause, e.g. If the 
clause is available at P:\Clauses\MyClause.docx, the tag would look like: 
{{OA INCLUDE P:\Clauses\MyClause.docx}} 

+ Clauses in SharePoint: PathToFragment will be the local path where the SharePoint location is 
synced to. SharePoint locations are synced to the user’s Windows User Profile. This needs to be 
a consistent location for all users, and each firm’s IT may need to ensure this is the case. 
When referencing file paths in the User Profile, use the special %USERPROFILE% path so a path 
can be specified that works for all users, e.g.: 
{{OA INCLUDE %USERPROFILE%\OrgSharePointLibrary\Clauses\MyClause.docx}} 

+ Clauses in a Clause Library: PathToFragment will be the name of the Clause Library specified 
between $ characters, followed by the path to the desired clause, including subfolders, e.g. If we 
have a Clause Library called “Will Clauses”, then the tag might look like: 
{{OA INCLUDE $Will Clauses$\Bequests\Bequest of Money.docx}} 

+ Fragments (in document templates): PathToFragment will be the form [Category\Name], e.g. 
for a Fragment like this: 

 

 

Figure 154 

The tag would be like this: 
{{OA INCLUDE [Closings\Formal]}} 

 
NOTE: It is generally recommended for clauses that a Clause Library is used rather than using direct paths in 
OA INCLUDE tags. This way, if the clause location ever gets moved, only the path in the Clause Library needs 
to be updated, and not the paths specified in all the OA INCLUDE tags. 
 

OA REMOVE tag 

A related tag to OA INCLUDE is OA REMOVE. OA REMOVE tags instruct the OneLaw software to remove 
trailing newlines or whole paragraphs upon document assembly. These are generally used in conjunction 
with OA INCLUDE to handle the case when no clause is desired, and an empty paragraph or empty numbered 
item is not desired.  
 
For example, if there is a merge field “MyInfoSheet.OptionalClause” which generally resolves to an OA 
INCLUDE tag, and therefore instructs a clause to be inserted, the template might have the following block: 
 

 

Figure 155 

 

… 
1. This is the clause before. 
2. «MyInfoSheet.OptionalClause» 
3. This is the clause after. 

… 
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In the scenario where the user wants no clause, the default behaviour of the merge field would be to resolve 
to empty text, i.e. “”.  This would result in the below: 
 

 

Figure 156 

The empty 2. Numbering is undesirable in this situation. To resolve this, the merge field can be changed to an 
OA REMOVE tag, which will result in the following: 
 

 

Figure 157 

 
The OA REMOVE tag comes in 2 forms: 

1. {{OA REMOVE NEWLINE}}: Removes a trailing newline, but only if the next character is a newline (i.e. 
end of paragraph) 

2. {{OA REMOVE PARAGRAPH}}: Removes the entire paragraph containing the OA REMOVE tag, 
including the trailing newline character. 

 

Using OA INCLUDE and OA REMOVE in Word IF fields 

It is possible to use Word IF fields to conditionally include clauses by specifying an OA INCLUDE tag as the 
resulting value of the IF field. For full details on how to use IF fields, see the Conditional Logic with IF Fields. 
 
The following IF field shows an example of how to optionally include a clause if a CheckBox InfoSheet field is 
checked, or otherwise remove the numbered item using OA REMOVE: 
 

 

Figure 158 

In this case, when the CheckBox is checked, TestClause.docx is inserted as numbered item 2. When the 
CheckBox is unchecked, numbered item 2 is completely removed. 
  

… 
1. This is the clause before. 
2.  
3. This is the clause after. 

… 

… 
1. This is the clause before. 
2. This is the clause after. 

… 

1. This is the clause before. 
2. {IF “«MyInfoSheet.IncludeTestClause»” = “true” “{{OA INCLUDE P:\Clauses\TestClause.docx}}”  

“{{OA REMOVE NEWLINE}}”} 
3. This is the clause after. 
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InfoSheet Choice List Fields 

When using an InfoSheet Choice List field, where multiple options are available, it is possible to use nested 
Word IF fields to insert different clauses for different values selected in the Choice List field. However, these 
nested IF fields are messy and hard to work with. A better way to associate clauses with Choice List field 
values is to make use of the additional values that can be specified on the choice field. 
 
For example, with the following Choice InfoSheet selected: 
 

 

Figure 159 

In this case, a nested IF field could be put into a precedent to pull in the appropriate clause or remove the 
paragraph as appropriate: 
 
{IF “«MyInfoSheet.Bequest-Clause»” = “Gift of Money” “{{OA INCLUDE P:\Clauses\GiftOfMoney.docx}}”  
“{IF “«MyInfoSheet.Bequest-Clause»” = “Gift of Pet” “{{OA INCLUDE P:\Clauses\GiftOfPet.docx}}”  
“{{OA REMOVE NEWLINE}}”}”} 
 
This nested IF structure gets unwieldy very quickly, so a better way to achieve the same result is to put the 
OA INCLUDE and OA REMOVE tags into the Additional Values on the Choice List: 
 

   

Figure 160 

 Then a single merge field can be used in the precedent: «MyInfoSheet.Bequest-Clause.Value1».  In this case 
the “.Value1” specifies that the merge field references the “Additional Value 1” values from the Choice List.   
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InfoSheet Fragment Selector 

As per the InfoSheet Choice List Fields section above, a clause picker can be included in an InfoSheet. This 
solution is highly flexible, but does have some negatives: 
 

+ When a clause is added or renamed, it is necessary to update the InfoSheet Choice List field 

+ It is necessary to code the OA INCLUDE and OA REMOVE tags into the Choice List field, which is a 
little technical 

 
For simple cases where a clause or fragment picker is required in an InfoSheet, where the picker would 
contain all clauses in a folder in a Clause Library (or Fragment category), where alphabetical order is 
acceptable, and where the picker is only automating a single clause selection, then it is possible to simplify 
the InfoSheet building process by using a Fragment Selector field.   
 
The Fragment Selector field is effectively an auto-populating drop-down list of clauses in a particular location, 
where the location can be a Clause Library, a subfolder in a Clause Library or a Fragment category. 
 
For example, given the following folder contents (for a folder under a Clause Library): 
 

 

Figure 161 

Then a Fragment Picker configured to use that folder would auto populate as follows (assuming None option 
selected): 
 

 

Figure 162 
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The above can be achieved by simply configuring the Fragment Selector field as follows: 
 

 

Figure 163 

The same principle applies to fragments uploaded to the Document Templates area. Simply choose a 
Category in the field definition, and the drop-down box will auto-populate with all fragments with that 
Category. Doing so will produce the result as shown below: 
 

 

 

Figure 164 
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Inline Fragment Picker 

 

Overview 

In some cases, users may prefer to be able to choose clauses when working in a document, with the context 
of the document content to guide them. Fragment Selectors in InfoSheets don’t meet this need, as all clause 
choices need to be made up-front before the document content is visible. In this case, it is possible to use an 
inline fragment picker. 
 
An inline fragment picker is a drop-down content control within a document that allows the user to pick a 
clause directly within the document. Using a simple Will as an example, the image below shows what these 
pickers look like within a document: 

 

Figure 165 

In this image, the red text shows the inline fragment pickers. Clicking on a picker reveals a drop-down menu 
of clauses: 
 

 

Figure 166 

Clicking on an item from the list will insert the selected clause: 
 

 

Figure 167 
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Inline clause pickers can be configured to include a “None” option: 
 

 

Figure 168 

Selecting <None> will remove the picker, including the trailing newline so no empty numbered items will be 
left behind. The Figure below shows how the “Select the Guardianship clause” has been removed after 
selecting <None>. 
 

 

Figure 169 

It is possible for clauses inserted by inline clause pickers to themselves contain inline clause pickers. For 
example, selecting “Include” on the bequests clause picker inserts a clause that contains a further picker: 
 

 

Figure 170 

 

 
 

 

Figure 171 

Inline clause pickers can be configured to support a selection of multiple clauses. In this case, when the user 
selects a clause, the picker remains in the document so a further clause can be chosen. Once all required 
clauses have been inserted, the user can dismiss the picker by selecting <Done>: 
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Figure 172 

 

 
 

 

Figure 173 

 

Adding Inline Clause Pickers to Precedents 

Inline clause pickers are added to precedents by adding drop-down content controls, then setting the Tag on 
the content control to a special value that marks it as a clause picker. This can be done with the following 
steps: 
 

1. Using the Developer tab in Word, add a drop-down content control to the precedent document: 
 

Figure 174 

2. Select the content control, then select Properties on Developer tab: 
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Figure 175 

3. The Content Control Properties dialog box will show: 

4. In the Title field, enter the text that should be displayed in the picker in the document. For example, 
for the below, “Select the Guardianship clause” would be entered in the Title field: 
 

5. Enter the appropriate OA tag into the Tag field. This is in the format: 
 
OA CLAUSE ClauseLocation Modifier 
 

a. ClauseLocation is the name of a Clause Library, or the name of a Clause Library with a 
subfolder path – e.g. “Will Clauses” or “Will Clauses\Guardianship” 

b. Modifier is optional, and can be one of: 
i. “\*ADDNONE” – this specifies that a <None> option is added to the list of clauses 

ii. “\*REPEATER” – this specifies that the picker remains in the document after a 
selection is made, allowing further clause or clauses to be inserted. A <Done> option 
is added to allow the user to dismiss the picker 

Figure 176 

Figure 177 
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For example, for the Guardianship picker in the examples above, which includes a <None> option, 
the Tag field might be: 
 
OA CLAUSE Will Clauses\Guardianship \*ADDNONE 
 
And for the Bequests picker, which supports choosing multiple bequest clauses, the Tag field might 
be: 
 
OA Clause Will Clauses\Bequests \*REPEATER 
 

6. Choose a colour for the picker title text. If this is left unchanged the title text will be red as per the 
example above. If a colour is selected, the title text will reflect that colour – for example in the 
Bequests example below, the title text is green: 

This is because the colour is set to green in the Colour field: 
 

 
 

 
  

Figure 179 

Figure 178 
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Signatures 

 

Introduction 

 
This section describes how to use and manage signatures in OneLaw, and how to include pre-defined 
signature blocks in precedents and fragments.   
 
The Signatures feature in OneLaw supports the following: 
 

+ Signing of any document at the cursor 

+ Signing of documents generated from precedents at pre-defined locations. 

+ Multiple signers per document 

+ Signing on behalf, based on well-defined signing delegation rules 

+ Easy management of signatures and delegation rules on the user records in OneLaw 
 

Applying Signatures 

 
Under the Home tab in Word, there is an Insert Signature tool.  
 

 

Figure 180 

NOTE: If the user does not have an electronic signature loaded against their user profile in OneLaw or doesn’t 
have permission to sign on behalf of anyone else, then when the Insert Signature tool is selected, the 
following message will be prompted. If this occurs, contact your system administrator. 
 

 

Figure 181 

The Insert Signature tool will insert an electronic signature at the cursor or placeholder. When using this tool, 
the following options are presented: 
 

+ Use My Signature: Selecting this option will insert the users own electronic signature  

+ Sign on Behalf of: This is a dropdown box that will show the signatures that the user is 
authorised to sign on behalf of. Selecting this option will insert the chosen user’s electronic 
signature  
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The electronic signature that has been chosen to use will have their user details populated. 
 

 

Figure 183    
  

Now that the signature has been chosen, select where the signature is to be inserted. There are two options 
for this: 
 

+ The first option is to insert the signature where the cursor is. This means that wherever the 
cursor is in the document, that’s where the electronic signature will be inserted 

 

 

Figure 184 

+ The second option is to insert the signature at the placeholder. This is a designated area within 
the document where the electronic signature will be inserted. As previously mentioned, there 
can be multiple placeholders in a single document 

 

 

Figure 185 

Once the appropriate details have been selected, click insert, and the signature will be inserted into the 
document. When inserting at a placeholder, other relevant information may be included, such as name, role, 
email address, and phone number.  

Figure 182 
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Managing Signatures 

 
Open OneLaw and navigate to the Administration tab > Users > and select the appropriate User. 
 

 

Figure 186 

Once the user is selected, navigate to the tab on the user profile called ‘Signature.’ Click on Choose Signature 
and upload the user’s signature. 
 

 

Figure 187 

There is also the option to apply permissions for users to be able to sign on behalf of other users, and vice 
versa. 
 

+ Authorised Signers: Choose who has the authority to sign on behalf of the user 

+ Delegated Signatures: Choose who the user can sign on behalf of 
 

 

Figure 189 

 
NOTE: If changes are made to a user’s selected authorised signers or delegated signatures, upon saving the 
updated user profile, all other user profiles will reflect said changes. 

  

Figure 188 
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Creating Signatures 

 
This section is a step-by-step guide for how to create an electronic signature for users. Signatures are saved 
to an external folder and uploaded against the user’s profile within OneLaw. 
 

Step 1: Prepare the Signature 

1. Use a plain white piece of paper and sign using either black or blue ink 
2. Scan the signed paper and save to your desktop  

 

Step 2: Edit the Signature 

For best results, resize and clarify the signature using a tool like Paint. Follow these steps: 
 

1. Open the scanned signature file in Paint 
2. Use the cropping tool to remove excess white space around the signature 
3. Resize the Signature: 

+ Click the ‘Resize and Skew’ button under the Image tab 

+ Resize the signature to match the firm’s standard dimensions. A recommended starting point is 
resizing to 100 Vertical Pixels, but adjustments may be required  

4. Remove Background Interference (Optional and not always required): 

+ Use the background removal tool available in Paint (Windows 11 or higher) to enhance the 
clarity of the signature 

 

 

Figure 190 

 

Figure 191 
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Step 3: Save the Edited Signature 

Once satisfied with the appearance of the signature, save the file as a .png or .jpeg in an external folder or 
secure location. According to the firm’s policy, save the user’s signature in a secure folder with restricted 
access permissions 

 

 

Figure 192 

NOTE: Resizing and editing may require some trial and error to achieve the desired size and clarity. 
 
Once a user’s signature has been saved, it needs to be uploaded to OneLaw against the user’s profile (see 
the Managing Signatures section above). 
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Set Up Precedents or Existing OneAuthor Templates with Signature Placeholders 

 
Electronic signatures have been designed so that they can be inserted either where the cursor is in a 
document or where a specific signing placeholder is within a document. There are multiple ways to set up a 
placeholder within a document: using bookmarks, content controls or a combination of both. 
 

Creating a Signature Placeholder Using Bookmarks 

To set up a signature placeholder using bookmarks, open the document and place the cursor where the 
placeholder should sit within the document. Navigate to the Insert tab. In the Links group, select the 
Bookmark button; this will insert a placeholder for the Bookmark. 
 

 

Figure 193 

Next, a tag needs to be assigned to the bookmark so that it can link to OneLaw and pull through the correct 
details. OA SIGNATURE is the prefix code for signature details. 
 
In the Bookmark Properties window, enter OA_SIGNATURE in the Bookmark Name field. Click ‘Add’ and close 
the window. 
 
NOTE: bookmarks don’t recognise spaces, use an underscore to represent a space between words, e.g. 
OA_SIGNATURE 
 

 

Figure 194 
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Additional tags can be assigned to bookmarks for user-specific details, such as author name, author initials, 
author role and date. Follow the steps above, but add the following suffixes to the OA_SIGNATURE tag: 
 

+ For Author Name: Use OA_SIGNATURENAME 

+ For Author Initials: Use OA_SIGNATUREINITIALS 

+ For Author Role: Use OA_SIGNATUREROLE 

+ For Author Email: Use OA_SIGNATUREEMAIL 

+ For Author Phone: Use OA_SIGNATUREPHONE 

+ For Author Mobile: Use OA_SIGNATUREMOBILE 

+ For Date: Use OA_SIGNATUREDATE 
 

 

Figure 195 

Dual or multiple signing is available for documents using the Insert Signature tool. If multiple signatories are 
required for a document, create additional tags to distinguish between them. For example: 
 

+ OA_SIGNATURE Signatory 1 or Author 

+ OA_SIGNATURE Signatory 2 or Partner 
 
Customise these tags to align with the firm's naming conventions. Finally, confirm each bookmark is tagged 
correctly, and its settings match the firm’s preferences. The placeholder is now ready for use in the document 
with the specified bookmarks and tags. 
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Creating a Signature Placeholder Using a Content Control 

To set up a signature placeholder using content controls, open the document and place the cursor where the 
placeholder should sit within the document.  
 
To insert a content control, navigate to the Developer Tab. If the Developer Tab is not visible, enable it by 
navigating to File > Options > Customise Ribbon, and check the box for Developer. 
 

 

Figure 196 

In the Controls group of the Developer tab, select the Picture Content Control button. This will insert a 
placeholder for the electronic signature. 
 

 

Figure 197 

Reshape the content control. Click and drag the edges of the content control to adjust its size and shape as 
needed. 
 
Next, a tag needs to be assigned to the content control so that it can link to OneLaw and pull through the 
correct details. OA SIGNATURE is the prefix code for signature details. 
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Click on the inserted content control to highlight it. In the Developer Tab, click Properties (located in the 
Controls group). In the Content Control Properties window: 
 

+ Enter OA SIGNATURE in the Tag field 

+ Set Show as: to ‘None’ from the dropdown menu 

+ Check the box for Contents cannot be edited to lock the control 

+ Click OK to save the settings 
 

 

Figure 198 

Additional tags can be assigned to bookmarks for user-specific details, such as author name, author initials, 
author role, and date. Follow the steps above, but add the following suffixes to the OA SIGNATURE tag: 
 

+ For Author Name: Use OA SIGNATURENAME 

+ For Author Initials: Use OA SIGNATUREINITIALS 

+ For Author Role: Use OA SIGNATUREROLE 

+ For Author Email: Use OA SIGNATUREEMAIL 

+ For Author Phone: Use OA SIGNATUREPHONE 

+ For Author Mobile: Use OA SIGNATUREMOBILE 

+ For Date: Use OA SIGNATUREDATE 
 

 

Figure 199 
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NOTE: Use plain text content controls for user-specific details. 
 
Dual or multiple signing is available for documents using the Insert Signature tool. If multiple signatories are 
required for a document, create additional tags to distinguish between them. For example: 
 

+ OA SIGNATURE Signatory 1 or Author 

+ OA SIGNATURE Signatory 2 or Partner 
 
Customise these tags to align with the firm's naming conventions. Finally, confirm each content control is 
tagged correctly, and its settings match the firm’s preferences. The placeholder is now ready for use in the 
document with the specified content controls and tags. 
 

Additional Information About Editing Picture Content Controls 

Edit the colour of a picture content control by: 
 

+ First untick the ‘Contents cannot be edited’ check box under the Properties – however, 
remember to re-select this once the editing of the picture content control is finished 

+ Navigate to the Picture Format Tab > Colour > Recolour > choose the desired colour option 
 

 

Figure 200 
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Stationery – Headers/Footers 

 

Introduction 

 
Firms can store and manage their Stationery in OneLaw. Stationery refers to a firm’s headers and footers (or 
letterhead), logos, styles and numbering. In this section, the focus is on header and footer templates. 
 
Header and footer templates are Word documents containing a firm’s header and footer, which can be 
manually applied to other documents or precedents or utilise the option to automatically apply a header and 
footer when creating a precedent. 
 
NOTE: Ensure header and footer templates are saved as Word documents (.docx files). 
 

Applying Headers/Footers 

 
Under the Home tab in Word, there is the Stationery tool. This tool will insert stationery into the selected 
document.  
 

 

Figure 201 

The Stationery tool is a dropdown list option to distinguish between Header and Footer and StyleSheets. 
Once the User has selected to insert a header and footer, they will be presented with all available options 
from OneLaw. 

 

 

Figure 202 

 

 

Figure 203 
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Figure 204 

        

Once the user has selected Header and Footer and then chooses the appropriate letterhead, they can then 
click Insert. This will insert the selected letterhead into their document.  
 
If the user has selected the incorrect letterhead, they can repeat the above step and select the correct 
letterhead. Users do not need to delete the letterhead manually. The correctly selected letterhead will 
override whichever header and footer is currently in the document. 
 
If the user wishes to remove all headers and footers from a document, they can do so by clicking Clear 
Headers and Footers. This will remove all headers and footers inside the document. 
 

 

Figure 205 
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Managing Headers/Footers 

 

Navigate to the Administration (or Templates) tab in OneLaw. Select Document Templates and scroll down 

to OneAuthor Stationery Templates. 

This area is where a firm can store and manage their header and footer templates. Firms can have multiple 

header and footer templates stored here, with the ability to set one header and footer template as the firm’s 

default. 

 

 

Figure 206 

 

Adding New Stationery in OneLaw: 
 

1. Click on the green plus (+) icon to the right of OneAuthor Stationery Templates 

2. Select Header and Footer from the Use dropdown box 

3. Give this stationery item a name e.g. Letterhead or Xmas Letterhead 

4. Browse to attach the appropriate stationery file 

5. If a header and footer template has been selected, there is an option to check the tick box to save 

this as the firm’s default letterhead 

 

Figure 207 
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Auto Apply Headers/Footers Creating Documents from Precedents 

 
When creating templates or precedents, there is the ability to automatically apply the firm’s default 
letterhead. This allows for scenarios such as if a change is made to a firm’s letterhead, instead of needing to 
individually update each document, if all documents requiring letterhead have the auto apply default set, 
then any changes to said default letterhead can be made and updated in OneLaw and then be pushed out to 
all documents. 
 
When in edit mode, navigate to the OneAuthor tab in Word. Only those with the Template Administrator 
permission will have this tab available in Word. Click on Template Stationery. A dialog box will pop up and 
provide the following options: 
 

+ Only apply to first page 

+ Auto Apply Default Stationery 
 
Check the box to Auto Apply Default Stationery. 
 

 

Figure 208 
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Building Headers and Footers 

 
Start with a new Word document. Standard Word rules apply when creating header and footer Templates. 
 
Header: Click into the header section of the document. Insert the firm’s logo and details.  
 

 

Figure 209 

Footer: Click into the footer section of the document. Insert the firm’s logo and details. Footers are also a 
common place where firms like to include additional fields such as client number, matter number and 
document ID. If fields are being used in a header and footer template, these will need to be content controls. 
 

 

Figure 210 

 

Figure 211 

 
Once the header and footer template is finalised, save the document as a .docx file and save it to an external 
folder or desktop. From there, it can be uploaded to OneLaw per the instructions in the Managing 
Headers/Footers section. 
 

Different First Page 

OneLaw respects the settings specified in Word around whether the header/footer on the first page is 
different.   
 

 

Figure 212 
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Stationery – StyleSheets 

 

Introduction 

 
StyleSheets provide a way to define a set of Word styles and other formatting, matching a firm’s style guide 
or standards, that can then be applied to other documents. OneLaw provides the capability to define 
multiple StyleSheets and apply them as needed to any document open in Word.   
 
When applying a StyleSheet, a user can select which styles and other formatting to apply to the current 
document in Word. Applying the StyleSheet will copy the selected styles into the current document, and if 
styles with the same names already exist, then they will be updated, and any content using those styles will 
be updated. 
 
All Word styles are supported, including headings, numbers and bullets, grid formats and body text formats 
including Normal. Additional formatting supported includes margins, spacing and justification. 
 

Applying Styles 

 
Under the Home tab in Word, there is the Stationery tool. This tool will insert stationery into the selected 
document.  
 

 

Figure 213 

The Stationery tool is a dropdown list option to distinguish between Header and Footer, and StyleSheets. 
Once the user has selected to insert a StyleSheet, they will be presented with all available options from 
OneLaw. 
 

 

Figure 214 

 

Figure 215 
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Once a StyleSheet has been selected, click Insert. This will insert the StyleSheet into the document.  
 
Available styles from a StyleSheet will appear in the Styles Ribbon. Users can also pop out this ribbon by 
clicking the bottom right-side arrow. 
 

 

Figure 216 

 

Managing StyleSheets 

 

Navigate to the Administration (or Templates) tab in OneLaw. Select Document Templates and scroll down 

to OneAuthor Stationery Templates. 

This area is where a firm can store and manage their StyleSheets. Firms can have multiple StyleSheet 

templates stored in OneLaw. 

 

Figure 217 
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Adding New Stationery in OneLaw: 

1. Click on the green plus (+) icon to the right of OneAuthor Stationery Templates 

2. Select StyleSheet from the Use dropdown box 

3. Give this stationery item a Name e.g. Letter Style or Deed Style or Court Style 

4. Browse to attach the appropriate stationery file 

 

Figure 218 

 

Building StyleSheets 

 
A StyleSheet provides a consistent and structured way to format documents. It defines how elements such as 
body text, headings and numbered lists appear throughout the document, ensuring visual coherence and 
ease of navigation. 
 

Normal 

The starting point for any StyleSheet is the Normal style, which governs the appearance of the main body 
text. 
 
To begin, open Microsoft Word and navigate to the Home tab to access the Styles group. 
 

 

Figure 219 

Enter the word "Normal" into the document and apply the Normal style from the Styles menu. 
 

 

Figure 220 
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Once applied, right click on the Normal style and select Modify.  
 

 

Figure 221 

This opens the Modify Style dialog, where default formatting can be specified, including font type, font size, 
line spacing, text alignment and colour. 
 

 

Figure 222 

After the desired attributes are set, click OK to apply the changes. This redefined Normal style forms the 
visual foundation for the remainder of the document. 
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Headings & New Styles 

With the Normal style established, the next step involves defining additional styles to support the 
document's structure, most commonly: heading levels, subheadings, tables, bullet points or other content 
categories. 
 
To modify an existing heading style, type the corresponding name (e.g. "Heading 1") into the document, 
apply the style via the Styles menu, then right-click the style name and select Modify. Within the Modify 
Style dialog, the formatting can be adjusted to match the intended function and appearance. 
 

 

Figure 223 

 

 

Figure 224 
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To create a completely new style, use the Add New Style button within the Styles pane. This allows for the 
assignment of a custom name and the configuration of all formatting options, including font settings, spacing 
and text effects. 
 

 

Figure 225 

Repeat this process for each additional style required within the StyleSheet. Each style can be tailored to 
match specific content needs. 
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Numbered Headings 

For documents requiring a structured outline, styles that involve numbering must be linked to a multilevel 
list.  
 
Begin by selecting text formatted with the first numbered style (e.g., "Heading 1"). Within the Home tab, 
under the Paragraph group, click on the Multilevel List icon and select Define New Multilevel List from the 
dropdown options. 
 

 

Figure 226 

 

 

Figure 227 

 

mailto:support@onelaw.co.nz
https://www.onelaw.co.nz/


 

 

120 
03 339 5032 | support@onelaw.co.nz | www.onelaw.co.nz 

 Document Assembly Manual 

When the Define New Multilevel List dialog appears, click the More button to access advanced configuration 
options. Each level of the list (Levels 1–9) can then be linked to a specific style (e.g. Heading 1, Heading 2, 
etc.). Number formats, alignment and positioning for each level can also be defined here. 
 

 

Figure 228 

 

Figure 229 

Upon completion of these settings, click OK to apply the style structure. 
 
Save the StyleSheet as a .dox file. See the above Managing StyleSheets section on how to upload StyleSheets 
in OneLaw. 
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